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TUYÊN BỐ BẢN QUYỀN 

 

Tài liệu này thuộc loại sách giáo trình nên các nguồn thông tin có thể được 

phép dùng nguyên bản hoặc trích dùng cho các mục đích về đào tạo và tham khảo. 

Mọi mục đích khác mang tính lệch lạc hoặc sử dụng với mục đích kinh doanh 

thiếu lành mạnh sẽ bị nghiêm cấm. 
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LỜI GIỚI THIỆU 

 

Adobe Photoshop (thường được gọi là Photoshop) là một phần mềm đồ họa 

chuyên dụng của hãng Adobe ra đời vào năm 1988. Photoshop được đánh giá là phần 

mềm dẫn đầu thị trường về sửa ảnh và được coi là chuẩn cho các ngành liên quan tới 

chỉnh sửa ảnh. Từ phiên bản Photoshop 7.0 ra đời năm 2002, Photoshop đã làm lên 

một cuộc cách mạng về ảnh. Phiên bản mới nhất hiện nay là Adobe Photoshop CS6. 

Ngoài khả năng chính là chỉnh sửa ảnh cho các ấn phẩm, Photoshop còn được 

sử dụng trong các hoạt động như thiết kế trang web, vẽ các loại tranh, hỗ trợ chương 

trình 3D... Nói tóm lại Photoshop có mặt gần như trong mọi hoạt động liên quan đến 

ảnh. 

Tài liệu này sẽ giới thiệu tới người đọc một cách toàn diện từ các khái niệm cơ 

bản đến nâng cao về công việc chỉnh sửa ảnh, thiết kế giao diện Web. Dù biên soạn rất 

cẩn thận nhưng cũng khó tránh khỏi những thiếu sót. Rất mong nhận được những ý 

kiến đóng góp về giáo trình. 

 
Hà Nội, ngày ..... tháng…..năm 2019 

Biên soạn 

Khoa Công Nghệ Thông Tin 

http://www.trungtamtinhoc.vn/2012/06/hoc-photoshop-day-photoshop-hoc.html
http://www.trungtamtinhoc.vn/2012/06/hoc-photoshop-day-photoshop-hoc.html
http://www.trungtamtinhoc.vn/2012/06/hoc-photoshop-day-photoshop-hoc.html
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CHƯƠNG TRÌNH TỔNG QUÁT MÔ ĐUN 

ĐỒ HỌA ỨNG DỤNG 

Thời gian môn học: 90 giờ (Lý thuyết: 27 giờ; Thực hành: 63 giờ) 

 

I. VỊ TRÍ, TÍNH CHẤT CỦA MÔ ĐUN 

Mô đun Xử lý ảnh là môn học bắt buộc thuộc nhóm các mô đun chuyên môn nghề 

được bố trí giảng dạy sau các môn chung. 

II. MỤC TIÊU CỦA MÔ ĐUN 

 Biết môi trường làm việc của phần mềm Photoshop; 

 Hiểu về các chế độ màu thường sử dụng trong quá trình xử lý ảnh; 

 Biết các kỹ thuật tách ghép hình ảnh, điều chỉnh màu sắc; 

 Biết các kỹ thuật tạo mặt nạ, tạo các hiệu ứng đặc biệt cho ảnh; 

 Biết các bộ lọc trong Photoshop; 

 Sử dụng thành thạo các công cụ trong Photoshop; 

 Làm việc thành thạo trên lớp (layer); 

 Chỉnh sửa được ảnh, điều chỉnh màu sắc tùy ý; 

 Phục hồi được ảnh cũ, nhàu, ố,...; 

 Tạo hiệu ứng cho bức ảnh, lồng ghép khung ảnh nghệ thuật; 

 Chèn chữ nghệ thuật vào trong bức ảnh; 

 Xuất ảnh với nhiều định dạng khác nhau; 

 In ảnh với màu sắc trung thực; 

 Có được tính sáng tạo, mỹ thuật, thẩm mỹ, linh hoạt. 

 
III. NỘI DUNG MÔ ĐUN: 

Nội dung tổng quát và phân bổ thời gian: 

 

Số 

TT 

 

 

Tên các bài trong mô đun 

Thời gian 

Tổng 

số 

Lý 

thuyết 

Thực 

hành, 

Bài tập 

Kiểm tra* 

(LT hoặc 

TH) 

 

1. 
Làm quen với môi trường làm việc 

của Photoshop 

 

8 
 

4 
 

4 
 

0 

2. Các lệnh xử lý vùng chọn 10 4 6 0 

3. Làm việc với Layer 18 5 11 2 
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4. Văn bản trên Photoshop 12 3 7 2 

5. Quản lý vùng chọn 11 3 8 0 

6. Điều chỉnh hình ảnh 11 2 8 1 

7. Các kỹ thuật nâng cao 12 4 8 0 

8. Làm việc với các kênh màu 8 2 6 0 

 Tổng cộng 90 27 58 5 



6 
 

 

Bài 1. LÀM QUEN VỚI MÔI TRƯỜNG LÀM VIỆC 

CỦA PHOTOSHOP 

Mã bài: MĐ17-01 

Mục tiêu: 

 Biết những khái niệm cơ bản trong Photoshop; 

 Biết môi trường làm việc và các thanh công cụ của Photoshop; 

 Sử dụng được các công cụ thông dụng trong Photoshop; 

 Làm biến dạng hình ảnh tùy ý; 

 Rèn luyện tính chính xác, sáng tạo, linh hoạt. 

Nội dung chính: 

Phần mềm Photoshop là phần mềm đồ hoạ chuyên dụng cho công việc chỉnh sửa ảnh 

trên máy tính được thiết kế bởi công ty Adobe (Công ty chuyên thiết kế các phần mềm 

đồ hoạ : Photoshop, Adobe Indesign, Illutrator…) 

I. Các khái niệm trong Photoshop 

1. Ảnh Kỹ thuật số 

Là khái niệm dùng để chỉ những bức ảnh đã được số hoá để đưa vào máy tính dưới 

dạng các file dữ liệu với các định dạng ảnh . Để nhập ảnh vào máy tính có nhiều cách 

khác nhau. 

Ví dụ : Quét ảnh bằng máy Scan, chụp hình bằng máy ảnh kỹ thuật số, nhập hình ảnh 

từ 1 chương trình đồ hoạ khác dưới định dạng ảnh, cắt từ phim VCD… 

2. Điểm ảnh 

Là những phần tử hình vuông cấu tạo nên file ảnh. Nói cách khác 1 file ảnh là tập hợp 

của nhiều điểm ảnh, số lượng & độ lớn của các điểm ảnh trong file ảnh phụ thuộc vào 

độ phân giải của file đó. 

 

3. Độ phân giải 

Là số lượng điểm ảnh trên 1 đơn vị diện tích (thường dùng inch). 

Ví dụ : Độ phân giải của ảnh bằng 72 nghĩa là ảnh có 72 điểm ảnh trên 1 inch vuông 

Có thể nói nếu độ phân giải thấp thì số lượng điểm ảnh ít, diện tích của mỗi pixel lớn, 

hình ảnh sẽ không được rõ nét. 

 

4. Vùng chọn 

Là miền được giới hạn bằng đường biên nét đứt được dùng để quy vùng xử lý riêng. 

Mọi thao tác xử lý hình ảnh chỉ có tác dụng bên trong vùng chọn. Vùng chọn được tạo 

ra bằng các công cụ tạo vùng chọn hoặc 1 số lệnh tạo vùng chọn khác. 

 

5. Layer 
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Là lớp ảnh, trong 1 layer chứa các vùng có điểm ảnh hoặc k có điểm ảnh . Vùng k có 

điểm ảnh đc gọi là vùng trong suốt (Transparent) 

 

6. Màu tiền cảnh 

Là 2 hộp màu cơ bản trong photoshop, biểu tượng của 2 hộp màu này được nằm dưới 

cùng trên thanh công cụ. Có thể hiểu 1 cách đơn giản, màu tiền cảnh là màu sẽ tô vào 

ảnh, còn màu hậu cảnh là màu nền giấy. Mặc định của màu tiền cảnh là màu đen còm 

mặc định của màu hậu cảnh là màu trắng. 

Muốn chọn màu cho 2 hộp màu này chỉ cần kich vào biểu tượng để gọi bảng Color 

Picker. 

Phím Default Foreground and Background Color (phím tắt D): Trả lại mầu mặc định 

cho 2 hộp màu Foreground Color & Background .Phím Switch Foreground & 

Background Color (phím tắt là X): hoán đổi màu giữa 2 hộp màu. 

 

II. Giao diện chương trình Photoshop 

1. Môi trường làm việc 

Giao diện của Photoshop cơ bản gồm 6 thành phần như sau : 

 Gồm 6 thành phần: 

a. Thanh Menu 

b. Thanh ứng dụng 

c. Thanh tùy biến 

d. Thanh công cụ 

e. Các nhóm bảng 
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f. Cửa sổ tài liệu 

A. Thanh Menu: 

B. Thanh ứng dụng: 

 

C. Thanh tùy biến: 

Là nơi thiết lập các thuộc tính cho từng công cụ. Ví dụ khi chọn công cụ Brush, thanh 

tùy biến sẽ hiển thị như sau: 

D. Thanh công cụ: 

Là nơi chứa các công cụ của photoshop .Các công cụ được chia thành 3 nhóm : 

- Nhóm công cụ tạo vùng chọn và di chuyển . 

- Nhóm công cụ tô vẽ. 

- Nhóm công cụ tạo Path, chỉnh sửa Path & công cụ gõ text. 

Ngoài các công cụ trên tool box còn chứa các phím chuyển đổi qua lại giữa các chế độ 

làm việc & 2 ô mầu Foreground, Background. 

E. Các nhóm bảng (palettes): 

Đây là nhóm dùng để quản lý hình ảnh & các tính chất khác của file ảnh . 

Gồm các bảng sau : 

 
- Nhóm 1 : 
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+ Bảng Navigato quản lý việc xem ảnh . 

+ Bảng Info thể hiện thông tin về mầu sắc & toạ độ của điểm mà con trỏ đặt tới. 

+ Bảng Histogam thể hiện biểu dồ đo điểm ảnh. 

- Nhóm 2 : 

+ Bảng Color quản lý về màu sắc. 

+ Bảng Swatches quản lý màu cho sẵn. 

+ Bảng Styles quản lý hiệu ứng cho sẵn. 

-Nhóm 3 : 

+ History quản lý thao tác đã làm đối với file ảnh. 

+ Acions quản lý các thao tác tự động. 

-Nhóm 4 : 

+ Layer quản lý về lớp. 

+ Channel quản lý các kênh màu. 

+ Path quản lý về path 
 

 

G. Cửa sổ tài liệu: 

Nơi thực hiện thao tác trên hình ảnh cần biên tập.. 
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2. Mở file ảnh 

Vào menu File / Open (Ctrl + O) để mở ra bảng thoại Open  chọn File 

3. Tạo file mới 

Vào menu File / New ( Ctrl + N ) để gọi hộp thoại New. Xuất hiện các thuộc tính 

như sau: 

+ Name : Đặt tên file 

+ Width : Kích thước chiều ngang. 

+ Height : Kích thước chiều dọc. 

+ Resolusion : Độ phân giải file ảnh. 

+ Color Mode: Chế độ màu 

+ Background Contents: Chọn thuộc tính cho lớp nền (Layer Background). 

4. Các thao tác di chuyển và phóng ảnh 

Phóng to (Z oom out) : Ctrl + (+) 

Thu nhỏ (Z oom in) : Ctrl + (-) 

Thu ảnh về mức độ vừa phải (Fit on screen) : Ctrl + 0 

Thu ảnh về 100%: Ctrl + Alt + 0 

5. Lệnh cuộn ảnh 

Khi đang ở dạng phóng lớn file ảnh muốn xem ảnh ở khu vực khác có thể dùng 2 

thanh cuộn trên 2 cạnh ngang & dọc của file ảnh. Hoặc có thể mượn công cụ hand 

trong khi sử dụng công cụ nào đó bằng cách giữ phím Spacebar (phím cách) xuất 

hiện biểu tượng hình bàn tay cuả công cụ hand, dùng nó để dịch chuyển cửa sổ làm 

việc sang khu vực khác. Sau khi thả phím Spacebar ra công cụ trở lại công cụ hiện 

hành 
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Bài 2. CÁC LỆNH XỬ LÝ VÙNG CHỌN 

Mã bài: MĐ17-02 

Mục tiêu: 

 Hiểu các lệnh xử lý vùng chọn; 

 Biết các phương pháp tô màu; 

 Chọn được vùng tùy ý; 

 Sử dụng thành thạo các thao tác trên vùng chọn; 

 Tô được màu tiền cảnh và màu hậu cảnh; 

 Rèn luyện tính chính xác, cẩn thận, linh hoạt, sáng tạo. 

Nội dung bài: 

I. Nhóm công cụ chọn vùng 

Khi sử dụng Photoshop, người sử dụng thường có nhu cầu chỉnh sửa chỉ trên một phần 

nào đó của hình ảnh, thay vì trên toàn bộ hình ảnh. Photoshop cung cấp cho chúng ta 

nhiều cách thức để tạo ra một vùng chọn (selection). Vùng chọn là tập hợp các điểm 

ảnh (pixels) sẽ chịu tác động của những thao tác mà chúng ta thực hiện. 

Học cách để chọn một vùng nhất định của tấm hình là một điều rất quan trọng. Một 

khi đã tạo được một vùng lựa chọn, chỉ có duy nhất vùng lựa chọn sẽ được chỉnh sửa. 

Những vùng nằm ngoài vùng lựa chọn sẽ không bị ảnh hưởng bởi những thao tác được 

thực hiện 

Khi một vùng chọn được tạo ra trong Photoshop, biên của vùng chọn sẽ được thể hiện 

bằng một đường chấm chấm nhấp nháy trông giống như một đàn kiến đang đi. 
 

(1) Vùng không chọn (non-selected area) 

(2) Vùng chọn (selected area) 

(3) Vùng chọn được biểu diễn bằng “đàn kiến đang đi diễu hành” 
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Để tạo vùng chọn, Photoshop cung cấp cho chúng ta những công cụ sau: 
 

1. Công cụ Rectangular Marquee  (phím tắt là chữ M): Dùng để tạo vùng chọn 

có dạng hình chữ nhật. 

2. Công cụ Elliptical Marquee  : Dùng để tạo vùng chọn có dạng hình ê-líp. 

Cách sử dụng 2 công cụ này: 

Chọn công cụ   hoặc  . Nhấn giữ và kéo chuột và từ 1 góc sang góc đối diện để 

tạo nên vùng chọn hình chữ nhật hoặc ê-líp. 

Cả 2 công cụ trên đều vẽ từ 1 góc đến góc đối diện 

 

Nhấn giữ phím Alt để vẽ vùng chọn xuất phát từ tâm (hình bên phải) 

Nhấn giữ phím Shift để vẽ vùng chọn hình vuông hoặc hình tròn 

 

3. Công cụ Single Row Marquee   : Cho phép tạo vùng chọn bao gồm những 

điểm ảnh nằm trên đường thẳng ngang. 

4. Công cụ Single Column Marquee   : Cho phép tạo vùng chọn bao gồm những 

điểm ảnh nằm trên đường thẳng dọc. 
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5. Công cụ Lasso   (phím tắt là chữ L): Cho phép tạo vùng chọn bằng cách vẽ tự 

do. 

*Cách sử dụng: 

Chọn công cụ . 

Nhấn giữ chuột và rê theo biên của phần hình ảnh cần chọn. Khi thả chuột ra, 

Photoshop sẽ tự động nối điểm đầu và điểm cuối lại để tạo thành vùng chọn. Trường 

hợp muốn vẽ vùng chọn bằng những đoạn gấp khúc thì nhấn thêm phím Alt. 

Công cụ Lasso dùng để chọn phần hình ảnh không có dạng hình học thông thường 

6. Công cụ Polygon Lasso  : Dùng những đoạn gấp khúc để tạo thành vùng chọn 

có dạng đa giác. 

Cách sử dụng: 

Chọn công cụ  

Bấm chuột vào 1 điểm đầu tiên trên biên của phần hình ảnh cần chọn. Thả chuột ra, di 

chuyển chuột đến 1 vị trí kế tiếp trên biên của phần hình ảnh cần chọn, sau đó bấm 

chuột để xác định điểm thứ 2. Đoạn gấp khúc đầu tiên đã được tạo ra. Tiếp tục làm 

như vậy cho đến khi đi qua toàn bộ phần hình ảnh mong muốn. Để tạo thành vùng 

chọn cần nối điểm cuối trùng với điểm đầu tiên, hoặc bấm đúp chuột để Photoshop tự 

động nối điểm đầu và điểm cuối của đường gấp khúc lại. 

7. Công cụ Magnetic Lasso : Cho phép tạo vùng chọn bằng cách tự động dò tìm 

biên giữa những vùng có màu sắc phân biệt trên hình ảnh. 

Cách sử dụng: 

Chọn công cụ  

Bấm chuột vào 1 điểm đầu tiên trên biên của phần hình ảnh mà bạn cần chọn. Thả 

chuột ra, di chuyển chuột dọc theo biên của phần hình ảnh cần chọn. Dựa trên sự 

tương phản của hình ảnh, Photoshop sẽ tự động vẽ những điểm định vị (fastening 

points) trên đường mà chuột đã đi qua. Để tạo thành vùng chọn cần nối điểm cuối 
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trùng với điểm đầu tiên, hoặc bấm đúp chuột để Photoshop tự động nối điểm đầu và 

điểm cuối. 
 

Các điểm định vị sẽ tạo nên vùng chọn 

Trên thanh tùy chọn (Options bar) có các tùy chọn cho công cụ này như sau: 

* Feather: làm mờ (blur) biên của vùng chọn bằng cách tạo ra một ranh giới chuyển 

tiếp (transition boundary) giữa vùng chọn và những điểm ảnh xung quanh. Việc làm 

mờ này sẽ làm mất chi tiết của những điểm tại biên của vùng chọn. Tuy nhiên, chỉ thấy 

tác dụng của Feather khi dời nội dung vùng chọn sang một hình ảnh khác hoặc tô màu 

vào vùng chọn. 

Ví dụ: Ta chọn một vùng chọn bao quanh bông hoa với các giá trị Feather khác nhau. 

Sau đó dời (move) hoặc dán (paste) bông hoa sang một hình ảnh khác. 

A. Ảnh gốc - B. Feather=0 - C. Feather=10 - D. Feather=30 
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* Anti-aliased: Chọn tùy chọn này để biên của vùng chọn được trơn, dịu, không bị 

răng cưa. Khi đó Photoshop làm dịu sự chuyển tiếp màu giữa những điểm ảnh biên 

(edge pixels) với những điểm thuộc nền của hình ảnh (background pixels). 

Có chọn Anti-aliased Không chọn Anti-aliased 

* Width (1 - 256 pixels): Xác định khoảng cách tự động dò tìm biên. 

* Contrast (1% - 100%): Xác định độ nhạy trong việc dò tìm biên của công cụ này. 

Giá trị lớn của Contrast chỉ cho phép dò tìm biên của những hình ảnh có độ tương 

phản cao. Giá trị nhỏ của Contrast cho phép dò tìm biên của những hình ảnh có độ 

tương phản thấp. 

* Frequency (0 - 100): Xác định tần số xuất hiện của các điểm định vị trên vùng chọn. 

8. Công cụ Quick Selection   (phím tắt là W) 

Công cụ này chỉ xuất hiện kể từ Adobe Photoshop CS3. Với công cụ này, bạn có thể 

chọn nhanh 1 vùng chọn bằng cách dùng một đầu cọ tròn có đường kính thay đổi được 

để tô lên phần hình ảnh cần chọn. 

Thanh tùy chọn của công cụ Quick Selection 

Cách sử dụng: 
 

Chọn công cụ Quick Selection 

Trên thanh tùy chọn (options bar), chọn chế độ: New   (để tạo một vùng chọn mới), 

Add to selection (để thêm vào vùng chọn) hoặc Subtract from selection   (để 

trừ bớt vùng chọn). 

Chọn Brush menu   hoặc nhấn phím [ và ] để thay đổi đường kính đầu cọ 

của công cụ. 

Chọn chức năng Sample All Layers để tạo vùng chọn dựa trên dữ liệu của tất cả các 

layers thay vì chỉ dựa trên layer hiện hành. 

Chọn chức năng Auto-Enhance để giúp cho vùng chọn được “trơn” hơn. 

Tô vào vùng hình ảnh cần chọn. 
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Nếu ngừng rê chuột, rồi sau đó rê tiếp vào vùng lân cận thì vùng chọn sẽ lớn ra và bao 

gồm cả vùng mới. 

Tô bằng công cụ Quick Selection để mở rộng vùng chọn 

9. Công cụ Magic Wand   (W) 

Công cụ này được gọi là “cây đũa thần”, cho phép tạo vùng chọn bao gồm những điểm 

ảnh (pixel) có màu tương tự với điểm mà ta click chuột vào. Sai số là Tolerance (thay 

đổi từ 0 đến 255). 

Công cụ này dùng để chọn những vùng hình ảnh có màu sắc gần như đồng nhất 

Cách sử dụng: 

Chọn công cụ Magic Wand  .Trên thanh tùy chọn (options bar), có các tùy chọn 

cho công cụ này như sau: 

•  

A: Tạo vùng chọn mới 

B: Thêm vào vùng chọn 

C: Trừ bớt vùng chọn 

D: Lấy phần giao của 2 vùng chọn 

• Xác định giá trị Tolerance (0 – 255). Cho Tolerance có giá trị nhỏ để chỉ chọn những 

điểm ảnh rất giống với điểm ảnh sẽ click chuột vào. Cho Tolerance có giá trị lớn để 

chọn vùng màu rộng hơn. 
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Tolerance = 60 Tolerance = 100 

• Anti-aliased để biên của vùng chọn được trơn, dịu. 

• Contiguous cho phép chọn vùng chọn liền kề (contiguous) hoặc không liền kề (non- 

contiguous). 

Thanh tùy chọn của công cụ Magic Wand 

 

II. Lệnh thao tác với vùng chọn 

a. Tô vùng chọn với màu của Foreground color: Nhấn phím Alt + Delete 

b. Tô vùng chọn với màu của Background color: Nhấn phím Ctrl + 

Delete 

 

 

 
b) 

a. Chọn toàn bộ hình ảnh: Chọn Select > All (Ctrl + A) 

b. Hủy bỏ vùng chọn: Chọn Select > Deselect (Ctrl + D) 

c. Chọn trở lại vùng chọn vừa hủy bỏ: Chọn Select > Reselect (Ctrl + 

Shift + D) 

d. Đảo vùng chọn: Chọn Select > Inverse (Ctrl + Shift + I hoặc Shift + 

F7) 

Đảo vùng chọn 

e. Hiện/giấu vùng chọn: Chọn View > Show > Selection Edges (Ctrl + H) 

III. Vẽ thêm vùng chọn: 
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Giả sử đã có một vùng chọn. Nhấn giữ phím Shift, rồi tạo một vùng chọn mới (bằng 

một trong các công cụ tạo vùng chọn) để vẽ thêm vào vùng chọn sẵn có. Để ý rằng có 

một dấu cộng xuất hiện cạnh bên con trỏ khi vẽ. 
 

 

Để cộng thêm vùng chọn, thay vì nhấn giữ Shift, có thể chọn biểu tượng   trên thanh 

tùy chọn 

IV. Loại trừ bớt vùng chọn: 

Giả sử đã có một vùng chọn. Nhấn giữ phím Alt, rồi tạo một vùng chọn mới (bằng một 

trong các công cụ tạo vùng chọn) để trừ bớt vùng chọn sẵn có. Để ý rằng có một dấu 

trừ xuất hiện cạnh bên con trỏ khi vẽ. 

Để trừ bớt vùng chọn, thay vì nhấn giữ phím Alt, có thể chọn biểu tượng   trên thanh 

tùy chọn 

V. Giữ lại phần giao của hai vùng chọn (intersection) 

Giả sử đã có một vùng chọn. Nhấn giữ phím Alt + Shift , rồi tạo một vùng chọn mới 

(bằng một trong các công cụ tạo vùng chọn) để lấy phần giao của hai vùng chọn. Để ý 

rằng có một dấu nhân xuất hiện cạnh bên con trỏ khi vẽ. 

 
Để lấy phần giao của vùng chọn, thay vì nhấn giữ phím Alt + Shift, có thể chọn biểu 

tượng   trên thanh tùy chọn 

 
VI. Các thao tác xoay ảnh 
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Trong khi lồng ghép ảnh chúng ta thường phải thay đổi kích cỡ của một phần 

ảnh nào đó để có thể phù hợp với file ảnh mới đang thực hiện 

1. Thao tác hiệu chỉnh vùng chọn hoặc lớp hiện hành 

+ Bấm chọn lớp ảnh hoặc vùng ảnh ở lớp cần hiệu chỉnh 

+ Chọn Edit->Transform sẽ cho các lựa chọn hiệu chỉnh sau: 

- Scale Phóng to, thu nhỏ ảnh chọn 

- Rotate Xoay vùng ảnh chọn 

- Skew Làm nghiêng ảnh 

- Distort Bóp méo ảnh 

- Perspective Bóp méo ảnh đối xứng 

(Sau khi chọn một trong số các chức năng trên, bấm kéo chuột tại các điểm góc ảnh để 

hiệu chỉnh cho phù hợp) 

- Rotate 1800 Xoay ảnh chọn 1800 

- Rotate 900 CCW Xoay ảnh 900 ngược chiều kim đồng hồ 

- Rotate 900 CW Xoay ảnh 900 xuôi chiều kim đồng hồ 

- Flip Horizontal Lật ảnh theo chiều ngang 

- Flip Vertical Lật ảnh theo chiều dọc 

Chú ý: Có thể thực hiện phóng to, thu nhỏ hoặc xoay ảnh bằng cách gõ tắt Ctrl + T 

(Xoay hoặc phóng to, thu nhỏ) 

2. Hiệu chỉnh toàn ảnh 

+ Chọn Image->Rotate Canvas cho các lựa chọn: 

- 1800 Xoay toàn ảnh 1800 

- 900 CCW Xoay toàn ảnh 900 ngược chiều kim đồng hồ 

- 900 CW Xoay toàn ảnh 900 xuôi chiều kim đồng hồ 

- Flip Horizontal Lật toàn ảnh theo chiều ngang 

- Flip Vertical Lật toàn ảnh theo chiều dọc 

Chú ý: Thao tác trên sẽ hiệu chỉnh toàn bộ các lớp có trong ảnh hiện hành 
 

 

3/ Thay đổi kích cỡ thực của ảnh trước khi in 

a. Thực hiện in toàn ảnh 

+ Mở ảnh cần In 

+ Chọn Image->Image side (hiện hộp thoại) 

- Pixel Dimension: Khoảng cách thực của ảnh theo Width và Height 

- Print side: Kích cỡ thực của ảnh (người sử dụng được phép thay đổi) 

- Resolution: Độ phân giải của ảnh 
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Chú ý: Khi thay đổi kích cỡ của ảnh trong hộp Print side 

- Theo đúng tỷ lệ: Lựa chọn Constrain Propotions 

- Kích cỡ tự do: Huỷ bỏ lựa chọn Constrain Propotions 

b. Chia ảnh thành nhiều phần nhỏ 

+ Mở ảnh gốc 

+ Chọn Image->Canvas Side (hiện hộp thoại) 

- Anchor: Bấm chọn góc cạnh cần lấy (thể hiện bằng hộp phân chia) 

- Width: Nhập chiều rộng của khung 

- Height: Nhập chiều cao của khung 

Bấm chọn OK (thu được một ảnh mới có kích thước lựa chọn và vị trí ứng với xác 

định trong Anchor) 
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Bài 3. LÀM VIỆC VỚI LAYER 

Mã bài: MĐ17-03 

Mục tiêu: 

 Hiểu về khái niệm lớp trong Photoshop; 

 Biết các chế độ hòa trộn thường dùng; 

 Biết bộ công cụ tô vẽ; 

 Thao tác thành thạo trên lớp; 

 Sử dụng được các chế độ hòa trộn; 

 Sử dụng thành thạo bộ công cụ tô vẽ; 

 Sử dụng thành thạo bảng màu; 

 Có được tính cẩn thận, linh hoạt, sáng tạo, óc thẩm mỹ. 

Nội dung bài: 

 

Ngoài những tính năng hiệu chỉnh và biến đổi hình ảnh, Photoshop cũng có khả năng 

phối ghép các hình ảnh hoàn toàn độc lập với nhau thành một tập tin hình ảnh tổng 

hợp phong phú, đặc sắc 

Có thể sao chép bất kỳ hình ảnh từ các tập tin hình ảnh khác đem vào tập tin hình ảnh 

với nguyên tắc chung là xây dựng trên lớp (Layer). 

Layers là các lớp ảnh chồng lên nhau ví như một quyển sách có nhiều trang sách. 

 

Nếu như 1 tấm ảnh chụp và cho vào máy tính và chưa chỉnh sửa hoặc lồng ghép thì nó 

đơn thuần chỉ có 1 lớp đó là lớp background. 

Muốn ghép thêm 1 hoặc 2 ..3 ...đối tượng vào trong tấm ảnh đó thì lần lượt các đối 

tượng đưa vào ghép trong ảnh gốc sẽ là layers 1, layers 2, layers 3..... 

Tất cả các layers đều có hình con mắt và cái bút lông 

hoặc là một mắt xích. Trường hợp không muốn làm 

việc với layers nào thì bấm vào hình con mắt thì layer 

đó sẽ không còn hiện trên ảnh nữa. Nếu là hình bút 

lông: có thể chỉnh sửa lớp đó. còn nếu là hình mắt xích: 

đã khoá lớp đó lại và không thể chỉnh sửa được lớp đó. 

 

Khi chỉnh sửa hoặc ghép xong ảnh, muốn lưu lại mà để 

nguyên các lớp đó để có thể chỉnh sửa lại các lần sau 

thì chúng ta lưu với đuôi ảnh .psd. 

Còn nếu như đã chỉnh sửa và lồng ghép xong theo 

đúng ý đồ thì lưu với đuôu ảnh là .jpg 
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Để hiển thị hộp thoại Layer: Menu Window Layers (F7) 

Ví dụ: Có một hình nền (background) làm hình nền cho hình trái tim (Layer) được tạo 

trong suốt sẽ nhìn thấy nền (bacground) 

 

Có thể chuyển đổi từ nền (background) sang lớp (Layer). Nhấp hai lần vào lớp 

background đó. Hiện hộp thoại chọn OK. 

 

Kết quả sẽ hiển thị một Layer “0” từ nền background đang hiển thị. Có thể tổ chức 

nhiều Layer nằm trên Layer. 
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 1 : Opacity Độ trong suốt (độ mờ đục) của Layer 

 2 : Fill Độ trong suốt của các Pixel màu (không kể màu của hiệu ứng). 

 3 : Layer Set 1 thư mục chứa (quản lý) các Layer 

 4 : Các Layer con bên trong thư mục Layer Set 

 5 : Các hiệu ứng trên Layer 

 6 : Lớp nền (background) 

 7 : Delete Layer: xóa Layer 

 8 : Create a new Layer: tạo một Layer mới 

 9 : Create new fill or adjustment Layer: tạo một lớp màu phủ hoặc một lớp hiệu 

chỉnh mới. 

 10 : Create a new set: tạo một Layer set (thư mục chứa các Layer con bên 

trong) 

 11 : Add Layer mask: tạo một lớp mặt nạ mới. 

 12 : Add a Layer Style: hiệu ứng trên Layer 

 13 : Ẩn Hiện Layer 

 14 : Layer hiện hành 

 15 : Các chế độ khóa Layer 

 16 : Blending Mode: các chế độ hòa trộn lớp 

I. Sử dụng các lệnh trên Layer 

 

1. Chọn Layer làm việc 

Kích vào tên lớp hoặc ảnh thu nhỏ của lớp trong bảng layer hoặc dùng công cụ 

move kích chuột phải lên file ảnh , xuất hiện danh mục các lớp chọn tên lớp cần 

làm việc . 

2. Tạo lớp mới 

Các trường hợp phát sinh Layers 

 Click chuột vào icon Create a new layer ở góc dưới phải bảng hiển thị 

lớp. 

 Kéo chuột một hình ảnh từ file khác sang sẽ tạo thành layer 
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 Chọn vùng chọn sau đó vào Menu layer -> new -> layer via copy sẽ tạo 

thành một layer mới 

 Chọn vùng chọn sau đó vào Menu layer -> new -> layer via cut sẽ tạo 

thành một layer mới 

 Nhân bản layer tạo thành layer mới riêng bằng cách nhấn Att + Drag 

chuột hoặc Duplicate layer 

 Nhập văn bản bằng công cụ type tạo ra một layer mới 

 

3. Xoá bỏ lớp 

 Right click trên layer cần xoá -> chọn : delete layer 

 Kéo layer cần xoá xuống biểu tượng thùng rác dưới đáy bảng. 

4. Copy 1 lớp 

 Right Click trên layer muốn copy - > chọn : Duplicate layer 

 Kéo layer cần Copy xuống biểu tượng Create new Layer dưới đáy bảng. 

5. Thay đổi trật tự lớp 

Cách 1: 

Trong hộp layer đặt con trỏ chuột vào layer muốn di chuyển -> trỏ hình bàn tay, 

nhấn giữ mouse và drag lên hoặc xuống dưới các layer. 

Cách 2: 

Chọn Layer cần thay đổi thứ tự vị trí. Menu Layer Arrange: 

 Bring Forward (Ctrl+]) Đưa Layer lên trên một vị trí 

 Send Backward (Ctrl+[) Đưa layer xuống dưới một vị trí. 

 Bring to Front (Ctrl+Shift+]): Đưa Layer lên trên cùng 

 Send to Back (Ctrl+Shift+[): Đưa Layer xuống dưới cùng 

 

Ẩn, hiện các lớp 

Muốn ẩn layer nào ta tắt biểu tượng con mắt (eye icon ) & muốn hiện thì kích 

chuột bật eye icon đó lên . 

6. Nối, mở nối các lớp 

Để liên kết tạm thời kích chuột vào biểu tượng ô vuông ngay cạnh biểu tượng eye 

Icon & muốn mở nối làm tương tự. 

7. Các lệnh dán lớp 

* Merge down ( Ctrl + E ): Dán kế layer phía dưới của layer hiện thời & có thể dán 

nhiều layer bằng cách nối link các layer muốn trộn . 

* Merge Visible (Ctrl + Shift + E ): Trộn tất cả layer & vẫn giữ nguyên layer ẩn . 

* Flatte Image : Dán tất cả các layer. 

8. Canh hàng giữa các Layers 
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Chọn Layer muốn canh hàng (Layer được chọn sẽ là Layer chuẩn, cố định vị trí, 

những Layer được liên kết với Layer này sẽ phải gióng hàng theo Layer này). 

Liên kết các Layer muốn canh hàng với Layer hiện hành. Menu Layer Align Linked 

(Hoặc chọn công cụ Move, sau đó chọn kiểu gióng hàng trên thanh Options): 

Các kiểu gióng hàng: 

 Align Top Edges: Canh bằng nhau trên đỉnh 

 Align Vertical Centers: Canh giữa theo phương dọc 

 Align Bottom Edges: Canh bằng nhau dưới đáy 

 Align Left Edges: Canh trái 

 Align Horizontal Centers: Canh giữa theo phương ngang 

 Align Right Edges: Canh phải 

Phân phối đều khoảng cách giữa các Layers (Distribute): 

Liên kết các Layer muốn phân phối đều (đối với lệnh này bắt buộc phải có từ ba Layer 

trở lên) 

Menu Layer Distribute Linked (Hoặc chọn công cụ Move, sau đó chọn kiểu gióng 

hàng trên thanh Options) 

Lưu ý: Hai layer ngoài cùng sẽ cố định nếu là phân phối đều theo chiều ngang, Layer 

trên cùng và Layer dưới cùng sẽ cố định nếu phân phối đều theo chiều dọc (Lấy tổng 

khoảng cách của hai Layer ngoài cùng chia đều cho các Layer bên trong được Link với 

nó). 

Các kiểu phân phối đều: 

 Distribute Top Edges: Phân phối đều theo đỉnh Distribute Vertical Centers: 

Phân phối đều theo tâm (tính theo phương dọc) 

 Distribute Bottom Edges: Phân phối đều theo đáy 

 Distribute Left Edges: Phân phối đều theo cạnh trái 

 Distribute Horizontal Centers: Phân phối đều theo tâm (tính theo phương 

ngang) 

 Distribute Right Edges: Phân phối đều theo cạnh phải. 

 

9. Blending Mode (các chế độ hoà trộn) 

Sử dụng các chế độ hòa trộn để tạo hiệu quả cho hình ảnh của lớp trên khi sử dụng hòa 

trộn với hình ảnh bên dưới. 

Normal 

Chuẩn, không hòa trộn 
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Dissolve 

Tạo hiệu ứng cọ vẽ khô trong một lượng Pixel được hòa trộn. 

Darken 

Kết quả nghiêng về màu tối, sắc độ đậm vẫn được bảo toàn, đậm hơn so với ảnh ban 

đầu. 

Multiply 

Kết quả đậm hơn so với ảnh ban đầu và có sự hòa trộn đều màu sáng và màu tối. 

Color Burn 

Tạo ra hiệu ứng chiếu sáng thường nghiêng về sắc nâu đỏ, những màu sáng trở nên rực 

rỡ, hiệu ứng thường tạo ánh sáng gắt trên nền đậm. 

Linear Burn 

Hiệu ứng gần giống Color burn nhưng độ chuyển màu bớt gắt hơn các độ chuyển sáng 

tối. 

Lighten 

Tạo ra kết quả sáng hơn so với ảnh ban đầu và làm giảm độ đậm trên hình ảnh. 

Screen 

Sáng hơn so với ảnh ban đầu, chế độ này ngược với hiệu ứng Multiply. 

Color Dodge 

Làm sáng màu nền để làm nổi bật màu hòa trộn thường nghiêng về những màu rực rỡ. 

Linear Dodge 

Hiệu ứng gần giống Color Dodge nhưng độ sáng bớt gắt. 

Overlay 

Ở chế độ này thường nghiêng về sắc độ nóng và rực rỡ. 

Soft Light 

Hiệu ứng gần giống hiệu ứng Overlay nhưng độ tương phản bị giảm đi, ảnh thường 

cho ánh sáng dịu. 

Hard Light 

Kết quả nghiêng về màu đậm. 

Vivid Light 

Tạo ảnh có độ rực rỡ làm tăng độ tương phản so với ảnh ban đầu. 

Linear Light 

Gần giống với hiệu ứng Vivid Light nhưng giảm độ tương phản. 

Pin Light 

Tạo kết quả rực rỡ màu tuy nhiên có tăng thêm các cấp độ trung gian. 

Difference 

Kết quả tạo ra một màu thứ ba khác biệt so với hệ màu ban đầu. 
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Exclusion 

Gần giống hiệu ứng Difference nhưng bị giảm độ tương phản. 

Hue 

Màu sắc bị hòa trộn và lẫn vào màu nền. Ở chế độ này thường có tông màu xám. 

Saturation 

Kết hợp độ xám và sắc độ của màu hòa trộn với màu nền. 

Color 

Hòa trộn có bảo lưu độ sáng tối của màu nền với sắc độ và cường độ của màu hòa trộn. 

Luminosity 

Nghiêng về thang độ xám nhưng màu rực rỡ ít bị hòa trộn. 

10. Opacity 

Ảnh trên layer sẽ trong suốt dần nhìn thấy rõ phần ảnh của layer bên dưới khi nhập giá 

trị opaticity giảm dần 
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Bài 4. VĂN BẢN TRÊN PHOTOSHOP 

Mã bài: MĐ17-04 

Mục tiêu: 

 Gõ được chữ tiếng Việt có dấu trên Photoshop; 

 Chỉnh sửa chữ với hình dạng và kích thước bất kỳ; 

 Tạo chữ với đường dẫn tùy ý; 

 Rèn luyện tính sáng tạo, thẩm mỹ. 

Nội dung bài: 

 

1. Công cụ Type 

Ta có thể dùng công cụ Text để tạo một nội dung văn bản, khi tạo chữ xong, sẽ dùng 

những hiệu ứng trên chữ nhằm tạo ra nét viền, tạo độ nổi, gán kết cấu gradient... với 

nhiều hình thức đa dạng. 

Nhóm công cụ Text: 

Horizontal Type Tool: 

Công cụ tạo văn bản theo chiều ngang. 

Thao tác thực hiện: 

 Chọn công cụ Horizontal Type Tool 

 Xác lập một số định dạng trên thanh Options (Fonts, Size,…) → Kích vào vị trí 

bất kỳ trên hình ảnh, nhập văn bản. 

 Nội dung văn bản sẽ được đặt tại Layer mới 

Vertical Type Tool: 

Công cụ tạo văn bản theo chiều dọc. 

Thao tác thực hiện: 

 Chọn công cụ Type 

 Xác lập một số định dạng trên thanh Options (Fonts, Size,…) → Kích vào vị trí 

bất kỳ trên hình ảnh, nhập văn bản. 

Các chức năng trên thanh options: 
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Toggle the Character and Paragraph Palettes: 

 Font: chọn kiểu Font 

 Style: kiểu thường, đậm, nghiêng 

 Size: Kích cỡ chữ 

 Leading: Khoảng cách dòng 

 Kerning: Khoảng cách giữa hai ký tự (tại dấu nhắc, không cần quét chọn 

văn bản) 

 Tracking: Khoảng cách giữa các ký tự 

 Vertically Scale: Co giãn văn bản theo chiều dọc 

 Horizontally Scale: Co giãn văn bản theo chiều ngang 

 Set the baseline Shift: Khoảng cách với đường nền ban đầu 

 Color: Màu văn bản 
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 Faux bold: Làm đậm văn bản (bất kể chế độ đậm, nghiêng,… ở bên ngoài thanh 

option như thế nào). Lưu ý, khi sử dụng chức năng này thì không cho phép sử 

dụng chế độ Create Warped Text. 

 Faux Italic: Tạo văn bản nghiêng (bất kể chế độ đậm, nghiêng,… ở bên ngoài 

thanh option như thế nào). 

Paragraph Palette: Thiết lập văn bản dạng đoạn 

Tạo văn bản dạng đoạn: Chọn một trong các công cụ text, drag mouse tạo một khung 

giới hạn đoạn văn bản, nhập văn bản vào bên trong khung này. 

 Left align text: Canh trái văn bản. 

 Center text: Canh giữa văn bản. 

 Right align text: Canh phải văn bản. 

 Justify last left: Canh thẳng hàng hai bên, trừ dòng cuối cùng canh trái. 

 Justify last centered: Canh thẳng hàng hai bên, trừ dòng cuối canh giữa. 

 Justify last right: Canh thẳng hàng hai bên, trừ dòng cuối canh phải. 

 Justify all: Canh thẳng hàng hai bên bắt buộc, kể cả dòng cuối cùng. 

Lưu ý: Khi nhập văn bản (dạng Type) sẽ tự phát sinh một Layer riêng (Layer T). 

Riêng với các dạng Type mask thì chỉ là một vùng chọn trên Layer hiện hành. 

Đổi Layer văn bản thành hình ảnh (Layer thường) 

 Click phải vào Layer văn bản → Chọn Rasterize Layer 

 Menu Layer Rasterize Type 

Horizontal Type Mask Tool: 

Công cụ tạo văn bản theo chiều ngang dạng mặt nạ vùng chọn. 

Thao tác thực hiện: 

 Chọn công cụ Horizontal Type Mask Tool 

 Xác lập một số định dạng trên thanh Options (Fonts, Size,…) → Kích vào vị trí 

bất kỳ trên hình ảnh, nhập văn bản. 

 Nội dung văn bản chỉ là vùng chọn, bạn phải tạo Layer mới để chứa văn bản. 

Vertical Type Mask Tool: 

Công cụ tạo văn bản dọc dạng mặt nạ vùng chọn. 

Thao tác thực hiện: 
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 Chọn công cụ Horizontal Type Mask Tool 

 Xác lập một số định dạng trên thanh Options (Fonts, Size,…) → Kích vào vị trí 

bất kỳ trên hình ảnh, nhập văn bản. 

 Nội dung văn bản chỉ là vùng chọn, bạn phải tạo Layer mới để chứa văn bản. 

 

 

 
2. Chữ uốn cong 

Uốn cong tức là cho phép làm biến dạng theo đủ loại hình dạng, chẳng hạn hình cung 

hoặc hình gợn sóng. Kiểu uốn được chọn là một thuộc tính của lớp chữ – có thể thay 

đổi kiểu uốn lớp bất cứ lúc nào cần hay thay đổi dạng uốn cong toàn thể. Tùy chọn 

uốn chữ giúp điều khiển chính xác hướng và phối cảnh của hiệu ứng. 

Thực hiện các thao tác sau đây: 

 Chọn lớp chữ. 

 Thực hiện một trong hai cách: 

 Chọn công cụ Type, nhấp vào biểu tượng Create Warped Text trên thanh 

Option. 

 Chọn Layer > Type > Warp text. 

Các tùy chọn trong hộp thoại 

 Chọn kiểu uốn từ menu Style. 

 Chọn hướng uốn chữ: Horizontal hoặc Vertical. 

 Chọn Blend định mức độ uốn chữ. 

 Horizontal Distortion và Vertical Distortion áp dụng phối cảnh cho chữ. 

 Nhấp OK. 

Gỡ bỏ Uốn chữ 

 Chọn lớp chữ đã bị uốn. 

 Chọn công cụ Type, và nhấp và Warp text trên thanh Option hoặc chọn Layer > 

Type > Warp text. 

 Chọn None từ menu Style, và nhấp OK. 

1. Bộ công cụ Path 

Khái niệm về Path 

Path là một đường hoặc một hình thể (shape) bất kỳ. Đường path có thể là đường path 

mở (hở) hoặc đóng (khép kín), và ta có thể chỉnh sửa đường Path theo ý muốn bằng 

các công cụ con bên trong hoặc kết hợp phím tắt. 

Đường Path có thể sử dụng để cắt lọc hình ảnh, vẽ hình dáng đối tượng và có thể xuất 

sang sử dụng ở những chương trình khác… 

Công cụ Pen: 
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Công cụ để tạo đường Path. 

Các chức năng trên thanh Options 
 

 

Thao tác thực hiện: 

 Chọn công cụ Pen Tool (P) 

 Trên thanh Options của công cụ Pen, chọn chức năng Paths 

Vẽ các đoạn thẳng: kích xác định điểm bắt đầu, nhả chuột, di chuyển chuột đến vị trí 

thứ hai và nhấp chuột để kết thúc. Muốn vẽ đoạn thẳng liên tục cứ lặp lại thao tác trên. 

Có thể bấm giữ Shift khi kích để vẽ được các đoạn thẳng đứng, ngang, hoặc xiên một 

góc 45o. 
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Vẽ đường cong: Giống các loại bút vẽ Bézier của các chương trình đồ họa. Kích xác 

định điểm bắt đầu, nhả chuột, di chuyển chuột đến vị trí thứ hai và drag mouse về 

hướng của điểm node (nút) kế tiếp. Động tác này làm xuất hiện một tiếp tuyến (handle, 

tay nắm) và đường vẽ sẽ uốn theo tiếp tuyến tại các node (nút) đó. 
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Vẽ đối tượng kín: Lặp lại thao tác giống như trên nhưng muốn khép kín đường path 

khi vẽ xong dời chuột đến điểm khởi đầu của đường path và thấy một vòng tròn nhỏ 

xuất hiện bên cạnh dấu hiệu ngòi bút và nhấp chuột vào đó lúc này đường path sẽ được 

đóng kín và tự hủy chọn. 

Freeform Pen Tool: 

Vẽ đường Path bằng cách drag mouse tự do. 

Thao tác thực hiện: 

 Chọn công cụ Freeform Pen Tool (P) 

 Nhấp giữ chuột và rê chuột để vẽ đường Path tự do 

Add Anchor Point Tool: 

Thêm node 

Thao tác thực hiện: 

 Chọn công cụ Add Anchor Point Tool (P) 

 Nhấp lên trên đường Path để thêm node vào đường Path 

Delete Anchor Point Tool: 

Xoá node 

Thao tác thực hiện: 



37 
 

 Chọn công cụ Add Anchor Point Tool (P) 

 Nhấp tại vị trí node trên đường Path để xóa node trên đường Path 

Convert Point Tool: 

Hiệu chỉnh tay nắm, biến node gãy nhọn thành node trơn, mịn 

Thao tác thực hiện: 

 Chọn công cụ Convert Point Tool (P) 

 Nhấp tại vị trí node cần chỉnh sửa thành node trơn mịn hoặc node gãy nhọn trên 

đường Path 

Công cụ Path Selection Tool (A): 

Dùng để chọn toàn bộ đường path để di chuyển. 

Thao tác thực hiện: 

 Chọn công cụ Path Selection Tool (A) 

 Nhấp chọn đường Path và di chuyển cả đường Path đến vị trí bất kỳ 

Công cụ Direct Selection Tool (A): 

Dùng để chọn điểm neo, node và di chuyển điểm neo, node. 

Thao tác: 

Trong thực tế chỉ cần dùng công cụ pen khi muốn chỉnh sửa một đường path. 

 Thêm node: Chọn công cụ pen và vẽ đường path, khi đưa con trỏ chuột vào 

đường path tại vị trí cần thêm node, nó sẽ tự động biến thành công cụ Pen+, 

nhấp chuột vào đường path để thêm node. 

 Xóa bỏ node: Chọn công cụ pen và vẽ đường path, khi đưa con trỏ chuột tại 

node trên đường path cần xoá node, nó sẽ tự động biến thành công cụ Pen -, 

nhấp chuột vào từng node để xóa bỏ node. 

 Chỉnh để biến node gãy nhọn thành node cong mịn: Nhấn giữ phím Alt và nhấp 

chuột vào node gãy nhọn đồng thời rê chuột để chỉnh sửa thành đường cong 

mịn. Bạn có thể di chuyển thanh điều khiền của node. 

 Muốn di chuyển node: Nhấn giữ phím Ctrl và nhấp chuột vào node đồng thời rê 

chuột và di chuyển node tới vị trí bất kỳ. 

 Để chuyển Path thành vùng chọn, ta bấm Ctrl+ Enter. Hoặc kích mouse phải, 

chọn chức năng “Make Selection…” 

 Muốn vẽ tiếp một đường Path có sẵn, ta bấm giữ Ctrl + kích chọn đường Path, 

kích vào node cuối cùng, sau đó vẽ tiếp bình thường. 

Làm việc với Path Palette 

Menu Window Path. 
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Path palette là nơi liệt kê và lưu trữ đường path. 

Các đường path được thể hiện bằng một hình thu nhỏ với cái tên workpath 

 New path: tạo path mới 

 Delete path: xóa đường path 

 Make selection: chuyển path thành vùng chọn 

 Make work path: chuyển vùng chọn thành đường path 

 Fill path with foreground color: tô màu nền cho đường path với màu foreground 

 Stroke Path with Brush: tô đường viền cho path với các dạng cọ Brush (Chọn 

Path, chọn cọ Brush, chọn nét cọ → Kích biểu tượng “Stroke path with Brush”) 
 

Tất cả các thao tác của công cụ vẽ theo hình dạng đều sử dụng trên bảng Options. 

 

* Rectangle 

Dùng để vẽ hình vuông, hình chữ nhật. 

* Rounded Rectangle 

Dùng để vẽ hình vuông, hình chữ nhật góc bo tròn (xác định Radius thay đổi góc bo 

trên thanh Options) 

* Ellipse 

Dùng để vẽ hình tròn, hình ellipse. 

* Polygon 

Dùng để vẽ hình sao, hình đa giác (xác định số cạnh tại vị trí sides trên thanh Options) 

* Line 
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Dùng để vẽ đường thẳng, nếu nhấn giữ phím Shift sẽ vẽ được một đường thẳng đứng 

hoặc đường thẳng ngang. 

* Custom Shape 

Dùng để vẽ những hình tự chọn trong thư viện trên thanh Options 
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Bài 5. HIỆU CHỈNH MÀU SẮC CHO ẢNH 

Mã bài: MĐ17-05 

Mục tiêu: 

 Biết các chế độ hiển thị hình ảnh trong môi trường Photoshop; 

 Biết các lệnh điều chỉnh màu sắc; 

 Xem ảnh với chế độ bất kỳ; 

 Điều chỉnh màu sắc tùy ý; 

 Có được tính sáng tạo, thẩm mỹ, cách tổ chức khoa học. 

Nội dung bài: 

Menu Image > Adjustments > 

1. Lệnh Levels 

Dùng để chỉnh sửa khoảng tông và độ cân bằng màu của hình ảnh bằng cách điều 

chỉnh các mức cường độ của vùng tối, vùng giữa tông và vùng sáng trong ảnh. 

 Nút tam giác màu đen: đại diện cho tông màu tối Shadow. 

 Nút tam giác màu trắng: đại diện cho tông màu sáng Highlight. 

 Nút tam giác màu xám: đại diện cho tông màu trung bình Midtone. 

Thao tác thực hiện: 

 Chọn lệnh Levels, hộp thoại xuất hiện. 

 Kích và di chuyển nốt tam giác nằm ở giữa trong ba nốt trong biểu đồ Input 

Levels. Nếu di chuyển về phía bên phải hình ảnh sẽ tối hơn. Ngược lại nếu di 

chuyển về phía bên trái của hộp thoại, hình ảnh sẽ sáng hơn. 

 Kích vào nút OK. 

Lưu ý: Thông thường dùng công cụ Eyedropper để thiết lập các điểm đen và điểm 

trắng tuyệt đối để cải thiện độ tông màu cho hình ảnh. 

Lệnh Auto Level 

Tự động hiệu chỉnh mức xám trung bình (Gamma). 

Lệnh Auto Contrast 
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Tự động hiệu chỉnh cường độ tương phản trong hình ảnh. 

2. Lệnh Curves 

Hiệu chỉnh đồng bộ các mức sáng – tối – trung bình. 

Thao tác thực hiện: 

 Chọn lệnh Curves 

 Di chuyển con trỏ và kích lên đường đồ thị (đường xiên từ góc dưới trái đến 

góc trái phải), sẽ xuất hiện một nốt vuông trên đường đồ thị đó. 

 Kích vào nốt vuông và rê chuột theo hướng trên trái là tăng sắc độ sáng. Ngược 

lại, kích vào một nốt vuông và chuột theo hướng dưới phải là tăng sắc độ tối – 

OK 

3. Lệnh Brightness Contrast 

Hiệu chỉnh sắc độ sáng tối và cường độ tương phản trong hình ảnh. 

Thao tác thực hiện: 

 Chọn lệnh Brightness Contrast 

 Di chuyển con trượt của thanh Brightness, nếu sang bên trái làm tối hình ảnh. 

Ngược lại, sang bên phải làm sáng hình ảnh. 

 Di chuyển con trượt của thanh Contrast, nếu sang trái là giảm độ tương phản. 

Ngược lại, sang bên phải sẽ làm tăng độ tương phản trong hình ảnh. 

 Kích nút OK. 

4. Lệnh Color Balance 
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Dùng để cân bằng màu sắc. 

Thao tác thực hiện: 

 Kiểm nhận một trong ba giá trị ở khu vực Tone Balance. 

1. Shadows: Tập trung thay đổi những vùng hình ảnh có sắc độ tối. 

2. Midtones: Tập trung thay đổi những vùng hình ảnh có sắc độ trung bình 

3. Highlights: Tập trung thay đổi những vùng hình ảnh có sắc độ sáng. 

4. Preserve Luminosity: Tùy chọn này cho phép duy trì độ sáng trong hình 

ảnh. 

 Di chuyển ba thanh trượt trong khu vực Color Balance. 

1. Cyan: Màu xanh da trời 

2. Red: Màu đỏ 

3. Magenta: Màu tím sen 

4. Green: Màu xanh lục 

5. Yellow: Màu vàng 

6. Blue: Màu xanh dương. 

 Kéo con trượt đến màu cần tăng trong hình ảnh và ra xa màu cần giảm trong 

hình ảnh. 

 Kích nút OK. 

5. Lệnh HueSaturation 

Dùng để hiệu chỉnh sắc độ, độ bão hòa màu và mức độ sáng tối cho hình ảnh. 
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Thao tác thực hiện: 

 Di chuyển các thanh trượt trong bảng HueSaturation 

1. Hue: Hiệu chỉnh sắc độ màu 

2. Saturation: Hiệu chỉnh độ bão hòa 

3. Lightness: Hiệu chỉnh độ sáng tối. 

 Colorize: Hình ảnh được chuyển sang sắc độ của màu Foreground hiện hành và 

vẫn bảo toàn độ sáng cho mỗi pixel. 

Lưu ý: Trong trình đơn sổ xuống của Edit, chọn một màu bất kỳ, chẳng hạn như Red 

(đỏ). Khi hiệu chỉnh, ta tác động lên nhóm màu thuộc tông màu đỏ. Tất cả màu còn lại 

vẫn giữ nguyên trạng thái ban đầu. 

Auto color: 

Tự động tinh chỉnh độ cân bằng màu trong hình ảnh. 

6. Lệnh Desaturate 

Chuyển đổi toàn bộ màu sắc của hình ảnh sang thang độ xám nhưng vẫn giữ nguyên 

hệ màu ban đầu, và nó chỉ ảnh hưởng đến hình ảnh trên Layer hiện hành. 

Thao tác: chọn lớp hình ảnh → Menu Image Adjustments Desaturate. 

7. Lệnh Replace Color 

Thay thế màu hiện hành được chỉ định bằng các giá trị màu mới. 
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 Fuzziness: Xác định phạm vi dải màu sẽ được chọn để thay thế. 

 Hình vuông màu đen: Hiển thị vùng chọn hiện hành. Vùng màu trắng trong 

hình vuông màu đen: Hiển thị vùng màu sẽ được thay thế 

 Hue: điều chỉnh tông màu 

 Saturation: Điều chỉnh cường độ màu 

 Lightness: Điều chỉnh độ sáng tối của màu 

 Ba công cụ Eyedroper: Dùng để xác định mẫu màu nào cần được thay thế 

1. Eyedropper (+): Dùng để chọn thêm mẫu màu 

2. Eyedropper (-): Dùng để loại bớt mẫu màu không cần thiết ra khỏi mẫu 

màu đã chọn. 

8. Lệnh Selective Color 

Hiệu chỉnh màu theo tông màu định chọn. 

Thao tác thực hiện: 

 Chọn tông màu trong menu sổ của nhãn lệnh Color. 

 Di chuyển các nốt tam giác của bốn thanh trượt: Cyan – Magenta – Yellow – 

Black. OK 
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Lệnh Channel Mixer 

Nhuộm ba màu theo từng kênh đơn (Red – Green – Blue) lên hình ảnh. 

Thao tác thực hiện: 

 Chọn một kênh màu đơn trong trình đơn Output Channel. 

 Di chuyển nốt tam giác của ba thanh trượt Red, Green, Blue trong khu vực 

Source Channel để hiệu chỉnh màu nhuộm. 

 Monochrome: sử dụng các mức xám. 

 Di chuyển nốt tam giác trên thanh trượt Contrast: để tăng hoặc giảm bớt độ dày 

đặc của kênh màu được chọn. 

 Kích nút OK. 

Muốn lưu giữ những hiệu chỉnh trong hộp thoại Channel Mixer ta kích nút Save. Khi 

cần sử dụng lại, ta kích nút Load. 

Gradient Map: 

Lệnh Gradient Map ánh xạ khoảng biến thiên thang độ xám tương đương của hình ảnh 

theo màu của mẫu tô gradient xác định. Vùng tối trong hình ảnh ánh xạ đến màu ở một 

đầu mẫu tô (bên trái), vùng sáng ánh xạ đến màu ở đầu còn lại (bên phải). 

Thao tác: 

 Mở hộp thoại Gradient Map 
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 Định rõ mẫu tô gradient sẽ áp dụng 

 Chọn các tùy chọn thích hợp: 

1. Dither: Làm mịn màu mẫu tô và giảm bớt hiệu ứng sọc 

2. Reverse: Đổi hướng biến thiên của mẫu tô Gradient, nghịch đảo hướng 

ánh xạ. 

 Ok 

9. Lệnh Invert 

Tạo âm bản cho hình ảnh. 

Thao tác thực hiện: chỉ việc chọn lệnh Invert. 

Hình ảnh minh họa: 

 
 

10. Lệnh Equalize 

Phân bố đều giá trị sáng trung bình. 

Thao tác thực hiện: chọn một vùng hình ảnh → chọn lệnh Equalize. Xuất hiện một hộp 

thoại: 

 Equalize selected area only: Chỉ bên trong vùng chọn. 

 Equalize entire image base on selected area: Phân bố đều đặn tất cả những pixel 

dựa trên những pixel bên trong vùng chọn. 

Sử dụng Equalize khi ảnh quét tối hơn so với ảnh gốc nhưng muốn cân bằng các giá trị 

nhằm tạo hình ảnh sáng hơn. 

11. Lệnh Variations 
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Cho phép điều chỉnh độ cân bằng màu, độ tương phản và độ bão hòa màu cho hình ảnh. 

Thường sử dụng để chuyển đổi hình ảnh đen trắng sang hình ảnh màu, đây là một việc 

không thể thiếu trong lĩnh vực nhiếp ảnh. 

Thao tác thực hiện: 

 Khu vực có hai ô mẫu nằm trên cùng giúp ta dễ dàng so sánh: 

1. Original: Mẫu hình ảnh ban đầu. 

2. Current Pick: Mẫu hình ảnh kết quả. 

 Khu vực có bảy ô mẫu giúp thay đổi tông màu. 

1. More Green: Thêm màu xanh lục 

2. More Yellow: Thêm màu vàng 

3. More Red: Thêm màu đỏ 

4. More Magenta: Thêm màu xanh dương 

5. More Blue: thêm màu xanh da trời. 

 Khu vực có ba ô mẫu nằm bên phải giúp ta thay đổi độ sáng tối. 

1. Lighter: Thêm sắc sáng 

2. Darker: Thêm sắc tối 

3. Current Pick: Kết quả điều chỉnh sáng tối. 
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Bài 6. ĐIỀU CHỈNH HÌNH ẢNH 

Mã bài: MĐ17-06 

 

Nhóm công cụ chỉnh sửa hình ảnh 

 

Chọn công cụ đơn: 

 Nhấn chuột trái vào công cụ cần chọn. 

 Dùng phím tắt để chọn. 

Chọn công cụ ẩn: 

 Cách 1: Nhấn giữ chuột đến khi danh sách công cụ bên trong hiện ra 

 Cách 2: Nhấn chuột phải lên nhóm công cụ để chọn công cụ ẩn trong nhóm. 

 Cách 3: Nhấn Shift + Phím tắt để chuyển lần lượt các công cụ ẩn trong nhóm. 

1. Clone Stamp : 

Dùng để sao chép hình ảnh 

Thao tác thực hiện: 

 Chọn công cụ Clone Stamp. 
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 Chọn cọ vẽ và ấn định các tùy chọn cọ vẽ. 

 Định rõ chế độ hòa trộn (Mode), độ mờ đục (Opacity) và diễn tiến nét vẽ. 

Lưu ý: Nếu lấy mẫu từ một hình ảnh và áp dụng cho một hình ảnh khác thì cả hai ảnh 

phải thuộc cùng chế độ màu. 

2. Healing Brush : 

Cho phép chấm sửa những chỗ chưa hoàn chỉnh. Tô vẽ bằng những pixel mẫu được 

chiết xuất từ hình ảnh hoặc họa tiết. Ngoài ra, công cụ này còn có thể so khớp mẫu kết 

cấu, độ sáng lẫn sắc thái của điểm ảnh mẫu so với điểm ảnh nguồn. 

Kết quả: Các pixel chỉnh sửa hòa trộn liền lạc với phần ảnh còn lại. 

 Sampled: cho phép sử dụng Pixel từ hình ảnh hiện hành 

 Pattern: chọn Pixel từ mẫu họa tiết. 

Lưu ý: Nếu lấy mẫu từ một hình ảnh và áp dụng cho một hình ảnh khác thì cả hai ảnh 

phải thuộc cùng chế độ màu. (trừ trường hợp một trong số đó là ảnh Grayscale) 

Nếu cần đảm bảo độ tương phản giữa các rìa nét vẽ của vùng đang chỉnh sửa, hãy 

chọn vùng trước khi áp dụng công cụ Healing Brush (để ngăn không cho màu tràn ra 

ngoài). 

3. Patch : 

Chấm sửa vùng ảnh được chọn bằng những Pixel lấy từ hình ảnh khác hay từ họa tiết 

nào đó. Tương tự như Healing Brush, Patch tool cũng cho phép so khớp mẫu kết cấu, 

ánh sáng và sắc thái của pixel mẫu so với pixel nguồn. 

Khi chấm sửa ảnh, nên chọn từng vùng ảnh nhỏ để ra kết quả chính xác hơn. 

 Source: Drag chọn một vùng ảnh dơ → đặt trỏ vào bên trong vùng chọn → drag 

sang vùng ảnh sạch gần nhất. 

 Destination: Drag chọn một vùng ảnh sạch gần vùng ảnh dơ nhất → đặt trỏ vào 

bên trong vùng chọn → drag đắp sang vùng ảnh dơ kề bên. 

 Ta có thể chỉnh sửa vùng chọn tương tự như thao tác với công cụ Lasso (bấm 

Shift để cộng thêm vùng chọn, bấm Alt để trừ bớt vùng chọn). 

4. Blur : 

Dùng để làm mờ các rìa hoặc vùng sắc nét trong hình ảnh để giảm bớt chi tiết. 

 

 Brush: Nơi chứa các loại cọ và kiểu cọ khác nhau. 
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 Mode: Các chế độ hòa trộn của công cụ 

 Strength: Áp lực phun của công cụ 

 Use All Layers: Làm mờ hình ảnh được chứa trong các Layer đang hiển thị. 

Thao tác thực hiện: 

 Chọn công cụ Blur 

 Xác lập các chế độ cần thiết trên thanh thuộc tính. 

 Kích và rê chuột liên tục lên hình ảnh. 

 Kết quả: hình ảnh sẽ bị mờ dần. 

5. Sharpen : 

Tập trung vào rìa mờ nhằm tăng độ sắc nét, dựa trên nguyên tắc làm tăng độ tương 

phản giữa các pixel nằm cạnh nhau. 

 

 Brush: Nơi chứa các loại cọ và kiểu cọ khác nhau. 

 Mode: Các chế độ hòa trộn của công cụ 

 Strength: Áp lực phun của công cụ 

 Use All Layers: Làm rõ nét hình ảnh được chứa trong các Layer đang hiển thị. 

Thao tác thực hiện: 

 Chọn công cụ Sharpen 

 Xác lập các tùy chọn thích hợp trên thanh options 

 Kích và rê chuột liên tục lên hình ảnh 

 Kết quả: hình ảnh sẽ rõ nét ở các biên. 

 Tuy nhiên, không nên sử dụng quá nhiều công cụ này. 

6. Smudge : 

Mô tả hành động miết ngón tay qua vùng sơn ướt. Công cụ này lấy màu ở vị trí bắt đầu 

và đẩy nó theo hướng drag mouse. 

 

 Brush: Nơi chứa các loại cọ và kiểu cọ khác nhau 

 Mode: Các chế độ hòa trộn của công cụ 

 Strength: Áp lực làm nhòe của công cụ 

 Use All Layers: Ảnh hưởng đến các Layer đang hiển thị. 

Thao tác thực hiện: 

 Chọn công cụ Smudge 



51 
 

 Kích và rê chuột trực tiếp lên hình ảnh theo hướng thích hợp. 

Nếu kiểm nhận tùy chọn mục Finger Painting: Quệt nhòe bằng màu foreground tại nơi 

bắt đầu từng điểm vẽ. 

7. Dodge : 

Dùng để làm tăng độ sáng cho hình ảnh. 

 

 Brush: Nơi chứa các loại cọ và kiểu cọ khác nhau 

 Range: Giới hạn vùng ảnh hưởng: Shadows: vùng tối; Midtones: vùng giữa 

tông; Highlights: Vùng sáng. 

 Exposure: Xác định độ sáng, giá trị càng lớn hiệu ứng càng mạnh. 

Thao tác thực hiện: 

 Chọn công cụ Dodge 

 Xác lập các giá trị cần thiết trên thanh Options. 

 Kích và rê chuột lên trên hình ảnh 

 Kết quả: hình ảnh sẽ sáng dần trên vùng kích chuột. 

8. Burn : 

Làm tối hình ảnh 

 

 Brush: Nơi chứa các loại cọ và kiểu cọ khác nhau 

 Range: Giới hạn vùng ảnh hưởng: Shadows: vùng tối; Midtones: trung bình; 

Highlights: Vùng sáng. 

 Exposure: Xác định độ sáng, giá trị càng lớn hiệu ứng càng mạnh. 

Thao tác thực hiện: 

 Chọn công cụ Burn 

 Xác lập các giá trị cần thiết trên thanh Options. 

 Kích và rê chuột lên trên hình ảnh 

Kết quả: hình ảnh sẽ tối dần trên vùng kích chuột. 

9. Sponge : 

Dùng để làm cho màu sắc của hình ảnh bão hòa hơn hoặc rực rỡ hơn. 

 

 Brush: nơi chứa các loại cọ và kiểu cọ khác nhau 
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 Mode: 

1. Desaturate: Tùy chọn này cho phép làm giảm cường độ màu. (màu sắc 

chuyển dần qua xám). 

2. Saturate: Tùy chọn này cho phép làm tăng cường độ màu (màu sắc rực 

rỡ). 

Kết quả: hình ảnh sẽ thay đổi màu sắc khi rê chuột trên vùng hình ảnh. 

10. Hộp thoại cọ (Brush) 

Hộp thoại Brush (trên thanh option) là nơi thể hiện kích thước và các dạng đầu cọ khác 

nhau cho các công cụ vẽ và chỉnh sửa như Brush, Eraser, History Brush, CloneStamp, 

Healing Brush, Smudge… 

Các dạng cọ mặc định 

Mặc định cho hộp cọ Brush là một số các dạng cọ vẽ có kích cỡ và nét cọ cứng, mềm 

khác nhau. 

Thư viện lưu trữ các cọ vẽ 

Ngoài các dạng cọ vẽ mặc định, Photoshop còn có một số thư viện cọ Brush khác. Để 

tải các cọ vẽ này, ta chọn Menu Brush palette chọn lệnh Load Brush và theo đường 

dẫn sau: 

 C:> Program file > Adobe > Photoshop CS4> Preset. Brush > *.ABR. 

 Hoặc chỉ cần vào Menu Brush palette và chọn thư viện cọ Brush muốn load ở 

phần cuối của bảng (Assorted Brushes …→ Wet Media Brushes). Khi chọn 

một trong các thư viện cọ này sẽ thấy xuất hiện một câu thông báo: 

 Ok: Thư viện cọ mới sẽ thay thế thư viện cọ mặc định. 

 Append: Vẫn giữ lại hộp cọ hiện hành, thư viện cọ mới sẽ được ghi nối vào 

phía sau thư viện hiện hành. 

Tự tạo nét cọ mới: 
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Dùng công cụ chọn vùng hình chữ nhật (Feather=0) → rê chọn một vùng hình ảnh 

muốn tạo nét cọ 

Chọn Menu Edit Define Brush. Đặt tên cọ và nhấp Ok, nét cọ mới sẽ được cập nhật 

vào cuối thư viện cọ hiện hành. 

Các lệnh trong Menu Brush Palette 

 New Brush Preset: Tạo một cọ vẽ mới 

 Rename Brush: Đổi tên cũ của cọ đang chọn sang tên mới 

 Delete Brushes: Xóa bỏ cọ vẽ đang chọn. 

 Reset Brushes: Trả lại chế độ mặc định cho hộp Brushes 

 Load Brushes: Nhập cọ vẽ khác 

 Save Brushes: Lưu các cọ hiện hành thành file *.ABR 

 Replace Brushes: Thay nét cọ hiện hành có trong Brushes thành dạng cọ khác 

Ngoài ra, ta còn có thể xác lập một số tùy chọn khác cho từng nét cọ Brush bằng cách 

kích biểu tượng Toggle the Brushes Palette 
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(ở góc trên bên phải của bảng Options) để thay đổi các hiệu ứng trên nét cọ. 

 Brush Tip shape: ấn định tùy chọn cho cọ vẽ: 

1. Master Diameter: Kích cỡ cọ vẽ 

2. Use sample Size: Sử dụng lại nét cọ vẽ ban đầu. 

3. Angle: Góc lệch so với phương ngang của độ dài cọ vẽ hình Ellip 

4. Roundness: Độ bo tròn của đầu cọ (100%: tròn, <100%: ellip) 

5. Hardness: Độ sắc nét của nét cọ. 

6. Spacing: Khoảng cách giữa các đầu cọ trong một nét vẽ. 

 Shape Dynamics: Các kiểu tùy chọn khác của nét cọ (Control: Fade, Pen 

pressure,…) 

 Scattering: Xác định độ phân tán, chi phối số lượng và vị trí hạt phun trên nét 

vẽ. 

 Texture: Áp dụng mẫu họa tiết kết cấu vào nét vẽ 

 Dual Brush: Sử dụng hai đầu cọ để tạo ra những nét vẽ. Ta xác định những tùy 

chọn cho đầu cọ thứ nhất với “Brush Tip Shape” và xác định cho đầu cọ thứ hai 

bắng “Dual brush”. 

 Color Dynamics: Quản lý việc thay đổi màu sắc trên đường đi của nét vẽ. 

 Other Dynamics: Dùng để tô màu trên đường đi của nét vẽ. 

 Noise: Tạo hiệu ứng hạt xung quanh nét cọ mềm biên. 

 Wet Edges: Sử dụng đường viền nét vẽ màu nước. 

 Shape Dynamics: Thay đổi hình dáng nét cọ vẽ. 

 Airbrush: Tạo hiệu ứng màu phun 

 Smoothing: Tạo ra nét vẽ trơn 
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 Protect texture: Áp đặt cùng một loại họa tiết cho các đầu cọ khác nhau để đảm 

bảo tính đồng nhất. 

* Nhóm cọ Brush 

Brush : 

Là công cụ tô vẽ bằng màu foreground với nét cọ mờ dịu (hoặc nét cọ cứng). 

 

 Brush: Nơi chứa các loại cọ và kiểu cọ khác nhau (thư viện nét cọ) 

 Mode: Các chế độ hoà trộn của cọ Brush 

 Opacity: Độ trong suốt màu của cọ vẽ 

 Flow: Áp lực phun màu của công cụ (giá trị càng lớn màu phun ra càng nhiều). 

Muốn vẽ đoạn thẳng: Kích xác định điểm thứ nhất, nhả mouse, bấm giữ Shift và tiếp 

tục kích xác định điểm thứ hai. 

Một số nét cọ Brush tiêu biểu: 
 

 

Pencil : 

Dùng để vẽ nét sắc, mảnh 

 

 Brush: Nơi chứa các loại cọ và kiểu cọ khác nhau (chỉ sử dụng đầu cọ cứng). 

 Mode: Các chế độ hòa trộn 

 Opacity: Xác định độ trong suốt của cọ 

 Auto Erase: Nếu vẽ trên vùng có cùng màu với màu Foreground thì nét vẽ sẽ có 

màu cùng với màu Background. Nếu vẽ trên vùng không cùng màu với hộp 

Foreground thì nét vẽ có màu của Foreground. 

11. Eraser 
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Thao tác thực hiện: 

Chọn công cụ Eraser -> Kích và rê chuột tự do lên hình ảnh 

 Brush: nơi chứa các loại cọ và kiểu cọ khác nhau 

 Mode: 

1. Brush: Tẩy xóa hình ảnh với biên vùng xóa mềm hoặc sắc cạnh. 

2. Pencil: Tẩy xóa hình ảnh với con trỏ hình tròn, biên vùng xóa sắc cạnh. 

3. Block: Tẩy xóa hình ảnh với con trỏ hình vuông, biên vùng xóa sắc cạnh. 

 Eraser to History: Lấy lại ảnh gốc ban đầu. 

 Opacity: Cường độ vết tẩy 

12. Art History 

Cọ vẽ nghệ thuật 

 

Chọn một trong các dạng cọ vẽ nghệ thuật trong danh sách Style và rê vẽ trực tiếp lên 

ảnh. 
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Bài 7. CÁC KỸ THUẬT NÂNG CAO 

Mã bài: MĐ17-07 

Mục tiêu: 

 Biết các kỹ thuật mặt nạ trong Photoshop; 

 Sử dụng được các lớp có sẵn, lớp điều chỉnh; 

 Tạo và sử dụng mặt nạ thành thạo; 

 Có được tính sáng tạo, thẩm mỹ. 

Nội dung bài: 

1. Layer Style 

Tạo hiệu ứng cho hình ảnh được chứa trong Layer đó. 

Thao tác thực hiện: 

Có nhiều cách mở bảng Layer Style 

 Nhấp hai lần vào Layer muốn tạo hiệu ứng 

 Kích phải mouse lên Layer muốn tạo hiệu ứng Blending Options 

 Kích biểu tượng ở góc dưới trái của palette Layer Chọn kiểu hiệu ứng 

* Drop shadow 

Hiệu ứng bóng đổ 

 Mode: Các chế độ hòa trộn của hiệu ứng 

 Opacity: Độ trong suốt của hiệu ứng 

 Use Global Angle: Ta chỉ cần thay đổi góc xoay của một hiệu ứng thì tất cả góc 

quay của hiệu ứng khác cũng thay đổi theo khi tùy chọn này được chọn 

 Distance: Khoảng cách của hiệu ứng đối với vật thể 

 Spread: Độ thắt (căng) của bóng 

 Size: Độ lớn của bóng, bóng càng lớn thì càng nhòe và có độ chuyển mềm 

 Contour: Kiểu viền của bóng 
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 Noise: Tạo nhiễu hạt 

Ví dụ: 

 

 

Inner shadow 

Hiệu ứng bóng bên trong 

 

 
 

* Outer Glow 

Hiệu ứng bóng quầng màu bên ngoài 

Blend Mode: 

 Nếu chọn màu tối thì Blend Mode nên chọn Multiply mới thấy rõ 
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 Ngược lại nếu chọn màu sáng thì Blend Mode nên chọn Screen hoặc Highlight 

sẽ thấy rõ hơn. 

 Opacity: Độ đậm nhạt của ánh sáng 

 Noise: Nhiễu hạt, khuyếch tán 

Màu của quầng sáng (Màu đồng nhất) 

Quầng sáng màu chuyển sắc. 

Technique: 

 Softer: Dịu, lan tỏa 

 Precise: Chính xác 

 Spread: Độ căng của quầng sáng 

 Size: Độ lan tỏa của quầng sáng 
 

 Contour: Kiểu viền của quầng sáng 

 Range: Phạm vi lan tỏa 

 Jitter: Có hiệu quả với kiểu phát sáng màu Gradient 
 

* Inner Glow 
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Hiệu ứng bóng quầng màu bên trong 
 

* Bevel and Emboss 

Hiệu ứng chạm nổi và vát cạnh. 

Style: 

 Outer Bevel: Hiệu ứng cạnh xiên bên ngoài 

 Inner Bevel: Hiệu ứng cạnh xiên bên trong 

 Emboss: Hiệu ứng chạm nổi 

 Pillow Emboss: Hiệu ứng chạm nổi khắc xuống 

 Stroke Emboss: Chạm nổi cho đường viền ( check vào hiệu ứng Stroke mới 

thấy được kiểu này) 

 Technique: 

 Smooth: Khối không sắc cạnh, trơn, nhẵn. 

 Chisel Hard: Khối gắt cạnh 1 chiều 

 Chisel Soft: Khối gắt cạnh hai chiều 

 Depth: Độ sâu của khối 

 Direction: Hướng của khối 

1. Up: Lên 

2. Down: Xuống 

 Size: Độ lớn của khối 

 Soften: Độ mềm mại của khối, khối bo tròn. 

 Angle: Hướng của khối 

 Gloss Contour: Kiểu bóng của khối 

 Higlight: 
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1. Mode: Các chế độ hòa trộn của highlight (phần sáng) 

2. Opacity: Độ trong suốt của highlight 

 Shadow: 

1. Mode: Các chế độ hòa trộn của bóng 

2. Opacity: Độ trong suốt của bóng 

 Contour: Viền cho khối

 Texture: Chất liệu lồng bên trong hiệu ứng 

 
 

Satin: 

Hiệu ứng tạo độ trơn láng, bóng nước 

 Opacity: Độ đậm màu sáng 
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 Angle: Góc xoay hướng 

 Distance: Khoảng cách màu Satin đến đối tượng 

 Size: Độ lớn của bóng 

 Contour: Chọn kiểu bóng 

Ví dụ 1: 

 

Ví dụ 2: 
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* Color Overlay: 

Hiệu ứng phủ một lớp màu lên đối tượng 

 Chọn màu để hòa trộn 

 Opacity: độ trong suốt của màu phủ. 

* Gradient Overlay: 

Hiệu ứng phủ một lớp Gradient (chuyển sắc) lên đối tượng 

Style: kiểu hòa trộn 

 Linear: Hòa trộn trực tiếp (thẳng) 

 Radial: tỏa tròn 

 Angle: Tỏa tròn kiểu hình nón 

 Reflected: Phản chiếu 

 Diamond: Tỏa vuông như ánh kim cương 

1. Angle: Góc xoay hướng tô 

2. Scale: Co giãn vùng màu chuyển 

Ví dụ 1: 
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* Pattern Overlay: 

Hiệu ứng phủ một lớp Pattern (mẫu tô) lên đối tượng 

 Chọn mẫu Pattern 

 Snap To Origin: Đúng vật liệu gốc 
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 Scale: co giãn vật 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
liệu 

* Stroke 

Hiệu ứng tạo viền cho đối tượng trên layer 

 Size: Kích thước đường viền 

 Position: 

Outsize: Đường viền hướng bên ngoài đối tượng 

Insize: Đường viền hướng bên trong đối tượng 

Center: Đường viền phát triển từ giữa biên đối tượng 

 Opacity: Độ trong suốt của đường viền 

 

 Fill Type: Các kiểu tô đường viền 

Color: Màu thuần 

Gradient: Màu chuyển sắc 

Pattern: Họa tiết 
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* Tạo bộ nút bằng Layerstyles 

Bước 1: 

Dùng công cụ vùng chọn ở chế độ Fixed size (Style) vẽ vùng chọn với kích thước 

ngang = 140 pixel, cao 25 pixel tô màu xanh dương đậm vào vùng chọn sau đó bỏ 

chọn. 

Bước 2: 

Hiển thị cửa sổ Layer (F7) nhấn chuột double click trên lớp(layer) này để hiển thị cửa 

sổ hiệu ứng layer styles. Kiểm nhận vào mục Bevel and Emboss và thay đổi các thông 

số tại mục Direction: up, size và soft. Để tạo hiệu ứng cho bề mặt của lớp nổi lên được 

kết quả. 
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Bước 3: 

Nhập văn bản nội dung nút là “GIỚI THIỆU, HỌC PHẦN, MÔN HỌC, ĐĂNG KÝ, 

LIÊN HỆ” sắp xếp bộ nút giống mẫu. 

Bước 4: 

Tạo hiệu ứng sáng lên để trang trí cho nội dung của bộ nút thêm phần bắt mắt hơn với 

nội dung của nút “GIỚI THIỆU, HỌC PHẦN, MÔN HỌC, ĐĂNG KÝ, LIÊN HỆ”. 

Tương tự phần tạo nền ở trên nhấn doule click để vào hiệu ứng Layer styles kiểm nhận 

vào hiệu ứng 

thay đổi các thông số trong bảng được kết quả chữ sẽ sáng lên nền. 
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Tùy theo trường hợp chỉnh các hiệu ứng cho phần trang trí nền và bộ nút của trang 

web cho đẹp mắt. 

Để tiện cho việc thiết kế bộ nút dùng hiệu ứng layer styles nhanh và chính xác. Người 

thiết kế có thể tạo một lần hiệu ứng và lưu lại các hiệu ứng trong của sổ Style. 

Chọn đúng lớp đã tạo hiệu ứng Layer style vào Window mở cửa sổ Style. Nhấp vào 

biểu tượng Create new style đặt tên cho style mới tạo “mau nut” nhấn OK công việc 

tạo và lưu Style đã hoàn tất. 

Sử dụng Style đã tạo và lưu cho một lớp mới. Khi người thiết kế cần sự giống nhau về 

kiểu hiệu ứng cho bộ nút. 

Ví dụ: 

Ở đây muốn áp dụng hiệu ứng chữ sáng cho các nội dung còn lại. Ta chỉ việc tạo một 

văn bản mới rồi chọn lại văn bản hiển thị cửa sổ Style, chỉ việc chọn vào tên Style đã 

tạo lúc này nội dung Layer hiện hành sẽ bị ảnh hưởng bởi kiểu Style này. 

Chọn hiệu ứng Style 
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2. Layer tô màu 

Làm việc với Bảng Swatches palette 

Swatches Palette là nơi chứa các mẫu màu, mặc định là 128 màu nhưng ta có thể thêm 

hoặc bớt những màu trên đó. 

 Mở đóng Swatches Palette: vào menu Window Swatches 

 Create New Swatches: tạo mẫu màu mới vào swatches. 

 Delete Swatches: xóa mẫu màu 

 Khi click chọn mẫu màu, màu sẽ xuất hiện ở ô màu foreground. 

Làm việc với Bảng Color palette 

Có thể thay đổi màu trong hệ RGB, CMYK, HSB để pha màu theo màu chỉ định. 

 Mở đóng Color Palette: vào menu Window Color 

 Di chuyển thanh trượt ở các dãy màu R, G, B hoặc nhập thông số vào ô màu để 

chọn màu thích hợp 

Chọn lựa màu foreground, Background 

Quan sát trên hộp công cụ ta sẽ thấy có biểu tượng hai ô màu, ô nằm trên là ô màu 

Foreground (tiền cảnh) và ô nằm dưới là ô màu Background (hậu cảnh). 

 Foreground: Màu tiền cảnh 

 Switch foreground to background colors: hoán đổi giữa màu tiền cảnh và màu 

nền (X) 



70 
 

 Background: Màu hậu cảnh (nền) 

 Default color: Tái lập mặc định màu đen trắng (D) 

Tô màu cho vùng chọn bằng màu Foreground: nhấn phím Alt + Del. 

Tô màu cho vùng chọn bằng màu Background: nhấn phím Ctrl + Del. 

Các công cụ tô màu 

Paint Bucket () 

Dùng để tô đầy một màu đồng nhất hoặc một mẫu họa tiết (Pattern) vào những Pixel 

liền kề có giá trị màu tương tự với pixel vừa nhấp. 

Thao tác thực hiện: 

 Chọn công cụ Paint Bucket 

 Chọn màu muốn tô trong ô màu Foreground. 

 Kích vào vùng chọn. 

 Hoặc nếu muốn tô bằng họa tiết thì chọn chế độ Pattern trong hộp Fill trên 

thanh Options. 

Gradient () 

Dùng để tô màu chuyển sắc. 

Linear Gradient: 

Màu biến thiên từ điểm đầu đến điểm cuối theo đường thẳng. 

Thao tác thực hiện: 

 Chọn công cụ Linear Gradient. 

 Kích điểm đầu và rê chuột tới một điểm cuối bất kỳ (Bấm giữ Shift trong khi rê 

mouse nếu muốn tô theo 1 đường thẳng). 

Radial Gradient: 

Màu biến thiên từ điểm đầu đến điểm cuối theo dạng tỏa tròn. 

Angle Gradient: 

Màu biến thiên nghịch chiều kim đồng hồ xung quanh điểm bắt đầu (giống hình chóp 

hay hình nón). 

Reflect Gradient: 

Màu biến thiên dựa trên mẫu gradient tuyến tính đối xứng ở một bên điểm bắt đầu. 

Diamond Gradient: 

màu biến thiên từ điểm bắt đầu hướng ra ngoài theo dạng hình thoi. Điểm cuối quyết 

định một góc của hình thoi. 

Mặt khác, có thể tùy chọn cách chuyển sắc trong bảng Gradient Options 

 Blending mode: Các chế độ hòa trộn 

 Opacity: Độ trong suốt 
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 Gradient: Các lựa chọn gradient khác nhau 

 Transparency: Cho phép tô kiểu Gradient trong suốt 

 Dither: Tạo mẫu hòa trộn mịn hơn, ít sọc hơn. Ở chế độ mặc định (tự động mô 

phỏng những màu không thể hiển thị được trên máy). 

 Reverse: Với tùy chọn này, màu Gradient được tạo ra sẽ bị đảo ngược vị trí so 

với màu đã chọn. 

 Click to Edit the Gradient ( ): nhấp để mở Gradient Editor, dùng 

để chỉnh sửa tính chất của màu Gradient đang được chọn. 

Sử dụng bảng Gradient Editor để thay đổi màu tô chuyển theo những góc độ khác 

nhau. 
 

 Thêm một nút màu trên dãy chuyển sắc: Kích 1 lần vào 1 điểm bất kỳ ngang 

hàng với các nút Color Stop 

 Đổi màu: Double click lên nút màu cần đổi 

 Xóa nút màu: Chọn nút màu cần xóa → kích nút Delete phía dưới bảng 

Gradient Editor hay chỉ cần kéo drag nút màu xuống dưới khỏi thanh màu. 

 Load thư viện gradient: Kích vào menu palette Gradient Editor chọn thư viện 

cần Load. 



72 
 

 Lấy lại thư viện mặc định: Kích vào menu palette Gradient Editor Preset 

Gradients… 

Tạo baner và bộ nút và tô màu Gradient vào vùng chọn, để baner giống mẫu sau : 

Phần baner được tô màu Gradient 480 x 72 pixel 

 
 

Eyedropper () 

Dùng để lấy màu mặt (foreground) hoặc màu nền (background) trên hình ảnh. 

Thao tác thực hiện: 

 Chọn công cụ Eyedropper, chọn một trong ba kiểu hút màu trên thanh Options. 

 Point Sample: hút màu tại một pixel được chọn 

 3 by 3 Average: lấy màu trung bình của 3*3 Pixel kế cận nhau. 

 5 by 5 Average: lấy màu trung bình của 5*5 Pixel kế cận nhau. 
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 Di chuyển con trỏ và kích vào một màu trên hình ảnh. Kết quả: màu lấy được sẽ 

hiển thị trong ô màu Foreground. 

 Bấm giữ phím Alt và kích vào một màu trên hình ảnh. Kết quả: màu lấy được 

sẽ hiển thị trong ô màu background. 

Ngoài ra, khi đang làm việc với một công cụ tô vẽ bất kỳ, ta có thể bấm Alt để chuyển 

tạm thời về công cụ EyeDropper. 

Color Sampler Tool : 

Hút lấy thông số màu. Cho xem tối đa là bốn thông số và các thông số này được hiển 

thị trên palette Info với số thứ tự tương ứng (#1, #2, #3, #4). 

Muốn xóa các điểm đã tạo ra bằng công cụ Color Sampler Tool: kích phải mouse tại 

điểm cần xóa và chọn Delete hoặc kích lệnh Clear (Clear All) trên thanh Options. 

Measure () 

Xác định tọa độ, góc, độ dài của một đối tượng. 

Thao tác thực hiện: 

 Chọn công cụ Measure. 

 Kích xác định một điểm trên hình ảnh và drag mouse sang vị trí thứ hai. 

 Quan sát ta thấy bảng con Info hoặc thanh Options, ta sẽ thấy kết quả thông qua 

sự thay đổi của các chỉ số. 
 

Một ứng dụng khác của công cụ Measure: Canh chỉnh hình ảnh bị nghiêng trở về dạng 

thẳng: Dùng công cụ Measure drag dọc theo bờ xiên của hình ảnh → Menu Image 

Rotate Canvas Arbitrary → Ok 

* Tô màu theo mẫu tô Pattern 

. Cách tạo mẫu tô Pattern 

Thao tác thực hiện: 

 Tạo đối tượng dùng để tạo mẫu tô 

 Nhấn Ctrl + A (chọn hết ảnh) hoặc chọn một vùng chọn bất kỳ trên mẫu 

 Chọn Edit Define Pattern (đặt tên mẫu tô -> OK) 

. Tô màu theo mẫu tô 
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Thao tác thực hiện: 

 Mở một tập mới 

 Chọn Edit Fill 

 Chọn các chức năng trong hộp thoại Fill 

1. Use: Chọn Pattern 

2. Custom Pattern: Chọn kiểu mẫu tô 

3. Mode: Chế độ hòa trộn (Normal) 

4. Opacity: Độ mờ 

 Nhấp OK 

 Mẫu tô sẽ được tô trên tập tin 

 

 

3. Sử dụng mặt nạ 

Layer mask (mặt nạ lớp) 

Mặt nạ sử dụng để che một phần của hình ảnh mà vẫn bảo toàn ảnh gốc. Mặt nạ chỉ sử 

dụng hai màu (của ô màu foreground): 
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 Trắng (hiển thị) 

 Đen (che) 

Thao tác: 

Cách 1: 

 Chọn layer ảnh muốn tạo mặt nạ che 

 Click biểu tượng (Add a Layer Mask) ở phía dưới Palette Layer sử dụng một 

trong các công cụ để che mặt nạ (công cụ Brush với đầu cọ mềm hoặc công cụ 

Gradient,…) 

Cách 2: 

 Chọn Layer muốn tạo mặt nạ che 

 Menu Layer Add Layer Mask 

 Reveal All: Hiển thị tất cả 

 Hide All: Che tất cả 

 Reveal selection: Hiển thị phần bên trong vùng chọn 

 Hide selection: Che phần bên trong vùng chọn 

 Mở tập tin 

 Import > Copy ảnh lên layer 2 

 Layer trên > Add layer mask 

 Dùng công cụ tô chuyển sắc vẽ chuyển sắc 

 Được kết quả 

 

Ví dụ minh họa 

 Hai ảnh ghép vào nhau sử dùng mặt nạ lớp (Layers mask) 
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Bấm chọn biểu tượng Add Layer mask để ghép hai ảnh lại 

 Sau khi ghép bằng mặt nạ lớp (Layer mask) 

Xóa mặt nạ: 

 Drag mặt nạ vào biểu tượng thùng rác (Delete Layer) phía dưới Palette Layer ' 

Xuất hiện câu thông báo: Discard: Xoá hẳn mặt nạ, đưa hình ảnh trở về trạng 

thái bình thường như trước khi sử dụng mặt nạ. Apply: Cập nhật mặt nạ lớp vào 

Layer hiện hành. 

 Hoặc Menu Layer Remove Layer Mask 

Vô hiệu hóa tạm thời mặt nạ: Menu Layer Disable Layer Mask (Shift + Click vào biểu 

tượng mặt nạ trên Layer). Sử dụng lại mặt nạ đã vô hiệu hoá: Menu layer Enable Layer 

Mask (Shift Click vào biểu tượng mặt nạ đã bị vô hiệu hoá trên Layer) 

Lưu ý: Khi làm việc với mặt nạ, ta phải bảo đảm rằng đang chọn lớp mặt nạ, nếu 

không sẽ làm ảnh hưởng trực tiếp lên hình ảnh đấy. 

Kết quả: Hình ảnh của Layer nằm trên sẽ bị mờ dần từ trên xuống theo độ chuyển sắc 

của lớp mặt nạ. 
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Bài 8. LÀM VIỆC VỚI CÁC KÊNH MÀU 

Mã bài: MĐ17-8 

Mục tiêu: 

 Trộn được các kênh màu; 

 Xuất ảnh với các định dạng khác nhau; 

 In ảnh trong môi trường Photoshop; 

 Chính xác, cẩn thận. 

Nội dung bài: 

 

1. Các kênh màu 

* Thông thường mỗi ảnh màu được tổng hợp bởi tập hợp một số màu chuẩn 

- Grayscale: Tập bởi 2 màu đen và trắng 

- RGB: Tập hợp bởi 3 màu RGB (tương ứng với 3 kênh màu chuẩn) 

- CMYK: Tập hợp bởi 4 màu (tương ứng với 4 kênh màu chuẩn) 

- Multiple channel: Chế độ ảnh đa kênh mầu (cho phép người sử dụng tạo thêm một số 

không giới hạn kênh màu mới) 

* Có thể sử dụng phương thức tăng hoặc giảm kênh màu đồng thời hiệu chỉnh chi tiết 

từng kênh để có được một ảnh màu chuẩn (có thể dùng phương pháp này để phục chế 

màu ảnh) 

 

A. Thao tác cơ bản trên kênh màu 

Mở File ảnh gốc -> Chọn Windows->Show Channel (hiện hộp thoại Channel liệt kê 

toàn bộ các kênh màu có trong ảnh) 

+ Bật hoặc tắt một kênh màu 

Bấm chuột vào biểu tượng Indicates Channel Visibility (biểu tượng mắt) 

+ Thêm một kênh màu mới (áp dụng cho toàn ảnh) 

Bấm chọn Create New Channel trên hộp Channel 

+ Loại bỏ một kênh màu 

Bấm phải chuột vào kênh màu cần loại bỏ và chọn Delete Channel 

+ Copy kênh màu 

Bấm phải chuột vào kênh màu cần Copy, chọn Duplicate Channel (hiện hộp thoại) 

- As Gõ vào tên kênh mới 

- Document Chọn File lưu trữ kênh (thường đặt trực tiếp trên File hiện hành) 

- Bấm chọn OK 

+ Đặt lại thuộc tính cho một kênh 
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Nháy kép chuột vào kênh màu cần hiệu chỉnh, xuất hiện hộp thoại cho các hiệu chỉnh 

chi tiết: 

- Name Tên của kênh hiện hành 

- Color Indicate Lựa chọn hiệu ứng màu của kênh đối với toàn ảnh 

- Color Bấm chọn màu và thay đổi áp lực của màu trên kênh (Opacity) 

Chú ý: 

* Trong phần Color Indicate cho ba lựa chọn 

- Masked Areas áp dụng kênh như một vùng chọn ảnh 

- Selected Areas Chỉ áp dụng cho một vùng chọn trên kênh mới tạo 

- Spot Color áp dụng hiệu chỉnh màu cho toàn ảnh (không có khả năng phục hồi 

phương thức khác) 

* Khi cần hiệu chỉnh màu cho ảnh bằng phương pháp hiệu chỉnh kênh ta nên lựa chọn 

trước vùng ảnh và lựa chọn Selected Areas (Channel Option) 

 

B. Tạo kênh màu áp dụng cho một vùng ảnh 

 

a. Tạo kênh trên vùng chọn ảnh 

+ Lựa chọn vùng ảnh cần hiệu chỉnh màu 

+ Bấm chọn Save Selection As Channel (trong hộp Channel) 

+ Nháy kép chuột vào kênh màu vừa tạo: 

- Channel Gõ vào tên cho kênh 

- Color Indicates Lựa chọn Selected Areas 

- Color Lựa chọn màu và thay đổi lại áp lực (Opacity) 

b. Chuyển kênh màu thành vùng chọn: 

+ Bấm chọn kênh màu tương ứng 

+ Bấm chọn biểu tượng Load Channel As A Selection (ta thu được một biên chọn ứng 

với áp dụng màu của kênh) 

Ghi chú: Ngoài phương thức đổ màu cho ảnh đã học ở phần trước, ta có thể áp dụng 

phương thức thêm bớt và hiệu chỉnh kênh màu để có được ảnh hiệu chỉnh màu hoàn 

thiện. 

 

2. Tương quan giữa chế độ màu và kênh 

Mỗi hình ảnh Photoshop có ít nhất từ 1 kênh trở lên, các kênh này chứa các thông tin 

màu cấu tạo nên hình ảnh 

+ Hình ảnh Grayscale , Doutone, Bitmap và Indexd color : Chỉ có 1 kênh 

+ Hình ảnh GRB : Có 4 kênh ( R,G,B và kênh tổ hợp ) 

+ Hình ảnh CMYK : Có 5 kênh ( C,M,Y,K và kênh tổ hợp ) 
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Lưu ý : Ngoài các kênh cá thể và kênh tổ hợp còn có các kênh khác được tạo ra thêm 

trong quá trình xữ lý ảnh được gọi là các kênh Alpha 

 

3. Chanel Palette 

Vào Window > Show Channel để hiển thị Channel Palette. 

a) Các nút lệnh dưới đáy Channel Palette : 

+ Load Channel as selection : Tải vùng chọn 

+ Save select as Channel : Lưu vùng chọn 

+ Create New Channel : Tạo kênh mới 

+ Delete current Channel : Xóa bỏ kênh hiện hành 

b) Các lệnh trong pop-up menu của Channel Palette : 

Phần lớn các lệnh đều tương tự như các nút lệnh dưới đáy Channel Palette trừ các lệnh 

sau : 

+ Split Channels : Tách kênh ( dùng để in tách màu ) 

Lệnh này sẽ tách tập tin ảnh có nhều kênh ra thành các tập tin tương ứng với số kênh 

màu ban đầu 

Mỗi tập tin sẽ chứa 1 kênh riêng rẽ ( ảnh trắng đen ) 

+ Merge Channels : Trộn kênh 

Lệnh này dùng để tái kết hợp các kênh riêng rẽ ( trắng đen ) để phục hồi lại hình ảnh 

(màu ) ban đầu 

 

4. Các lệnh trộn kênh (Merge Channel ) : 

+ Mở tất cả các tập tin chứa các kênh riêng rẽ định kết hợp rồi kích hoạt 1 trong những 

kênh hình ảnh đó 

+ Vào pop-up menu của Channel Palette chọn lệnh Merge Channels 

+ Trong cửa sổ Merge Channels chọn chế độ màu thích hợp rồi nhấp OK 

+ Trong hộp Merge xác nhận các kênh màu tương ứng của tập tin rồi nhấp OK 

 

5. Xuất ảnh và in ấn 
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Để tạo ra màu sắc phù hợp, xác định khoảng màu để chỉnh sửa và hiển thị hình dưới 

dạng RGB tiếp sau đó là chỉnh sửa, hiển thị và in hình dưới dạng CMYK. Với cách 

làm này có thể chắc chắn hình được in ra sẽ có màu giống như khi nó hiện trên máy 

tính vậy. Chương sẽ giúp thiết lập màu sắc giữa hai hệ màu RGB (cho việc hiển thị) và 

CMYK (cho in ấn) 

 

Trong bài này chúng ta sẽ học những phần sau 

 Xác định những mảng kiểu màu RGB, grayscale và CMYK trong việc hiển thị, 

in ấn và chỉnh sửa ảnh. 

 Chuẩn bị cho việc in ảnh trên một máy in PostScript CMYK. 

 Chuẩn bị trước khi in. 

 Tạo các mảng màu (separation), quá trình xử lý màu cho một hình RGB được 

bố cục bởi bốn màu mực in : cyan, magenta, yellow và black. 

 Hiểu các bước chuẩn bị trước khi in. 

 Tái tạo màu 

Tái tạo màu 

Màu sắc hiển thị trên màn hình được kết hợp bởi màu đỏ, xanh lá cây và xanh 

dương(hay được gọi là RGB), trong khi những màu được in ra lại được tạo bởi bốn 

màu lam,đỏ tươi (cánh sen), vàng và đen(hay được gọi là CMYK). Đây là bốn màu 

chuẩn trong quá trong in màu. 
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Bởi vì RGB và CMYK sử dụng các phương thức hiển thị khác nhau, chúng có 

những phương thức tái tạo các gam màu hay mảng màu khác nhau. Ví dụ, RGB sử 

dụng các gam sáng để tạo màu, gam màu của nó bao gồm những màu neon (neon 

colors). Ngược lại, màu của mực in lại vượt trội trong việc tái tạo những màu mực có 

thể ngoài phạm vi gam màu của RGB như là màu nhạt và màu thuần đen. Để rõ sự 

khác biệt giữa gam màu RGB và CMYK xem hình 18-3,18-4 và 18-5. 

 

Nhưng không phải tất cả các gam màu RGB và CMYK là giống nhau. Đối với mỗi 

một kiểu màn hình hay máy in, chúng đều hiển thị các gam màu có đôi chút khác nhau. 

Ví dụ như màn hình của nhà sản xuất này có thể hiển thị màu xanh dương hơi sáng 

hơn so với màu của nhà sản xuất khác. Màu sắc cho hình vẽ được quyết định bởi các 

gam màu mà nó có thể tái tạo 

Chúng ta sẽ xem xét qua một chút về hai hệ màu RGB và CYMK 

 

Hệ thống màu RGB 

Hầu hết các màu đều có thể thể hiện được qua ba màu là Đỏ (Red), Lục (Green), Lam 

(Blue) với cường độ sáng rất cao. Khi phối hợp lại chúng cũng có thể tạo được các 

màu CYM và W (trắng), nên chúng cũng được gọi là hệ màu Cộng. Tất cả các màu 

được phối hợp với cường độ sáng cao nhất sẽ tạo ra màu trắng, vì tất cả các ánh sáng 

sẽ được ánh xạ ngược trở lại mắt và tạo nên màu trắng. Hệ màu cộng được sử dung 

trong màn hình, video, ánh sáng. 

 

Hệ thống màu CYMK 

Là việc tạo màu dựa theo sự hấp thụ ánh sáng của mực in lên giấy. Khi ánh sáng đập 

vào mực in, một số bước sóng được hấp thụ trên giấy, một số khác được phản xạ vào 

mắt. Theo lý thuyết, màu Xanh lục (Cyan), màu Vàng (Yellow) và màu Cánh sen 

(Magenta) kết hợp với nhau hấp thu ánh sáng tạo nên màu Đen và chúng được gọi là 

hệ màu Trừ. Tuy nhiên do trong thực tế, các hạt mực in kết hợp với nhau tạo thành 
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một màu đen không thuần khiết, nên người ta cho thêm một lớp màu đen nữa để tạo 

nên màu đen thuần khiết, vì để tránh lầm lẫn với màu xanh nên được viết tắt là K. Việc 

kết hợp những màu mực in này được gọi là tiến trình in bốn màu. 

 

ICC ( International Color Consortium) : Một tổ chức định ra tiêu chuẩn màu sắc giúp 

cho các phần mềm và các thiết bị có thể hiểu được nhau (ND). ICC profile là một tập 

hợp những thông số nhằm đặc tả không gian màu của một thiết bị, ví dụ : không gian 

màu CYMK nhằm sử dụng cho các thiết bị in ấn. Trong bài này ta sẽ học cách sử dụng 

các tập màu RGB và CMYK. Photoshop (hay các ứng dụng có thể sử dụng định nghĩa 

màu theo chuẩn ICC) sẽ sử dụng những thông số theo chuẩn ICC để quản lý màu cho 

các file hình ảnh của mình. Ta có thể tham khảo thêm về việc quản lý màu và chuẩn bị 

những xác lập cho màn hình trong bài 

19. Trước khi vào bài chúng ta cần xác lập mặc định cho Adobe photoshop trong phần 

“Khôi phục những tham chiếu mặc định”. 

 

Chỉ định những xác lập quản lý màu 

Trong phần đầu bài này chúng ta đã được biết làm thế nào để xác lập một tiến trình 

quản lý màu. Để hỗ trợ việc xác lập này, Photoshop tự động hiển thị một hộp hội thoại 

cho việc xác lập màu ngay khi khởi động Photoshop. Ví dụ, Photoshop sẽ xác lập màu 

RGB là mặc định cho quá trình hỗ trợ web. Tuy nhiên ta cũng có thể thay đổi xác lập 

nhằm phù hợp cho việc in ra những bức ảnh đẹp hơn là hiển thị chúng trên màn hình. 

Để bắt đầu cho việc xác lập màu này, chúng ta hãy khởi động Photoshop, và bắt tay 

cho việc tùy biến màu sắc theo ý của mình. 

 

1. Khởi động Photoshop 

Nếu sử dụng những ứng dụng khác để thay đổi những xác lập trong file định nghĩa 

màu mặc định, một hộp hội thoại xuất hiện nhắc nhở ta đồng hóa màu sắc theo những 

xác lập bình thường hoặc mở lại hộp xác lập màu sắc của Photoshop. 

Việc đồng hóa những xác lập màu nhằm đảm bảo cho việc Photoshop sử dụng màu 

của minh được đồng nhất với các ứng dụng khác của Adobe cũng sử dụng hộp thoại 

Color Setting. Bạn cũng có thể chia sẻ những thông số thiết lập màu của bạn cho người 

khác bằng cách lưu lại xác lập màu vào một tập tin của ứng dụng mà bạn muốn và 

dùng để tái sử dụng cho các ứng dụng, hay chia sẻ với những người khác. 

2. Trên thanh menu, chọn Edit > Color Setting để mở hộp hội thoại “Color Settings” 
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Ở dưới cùng của hộp thoại chứa thông tin về nhiều lựa chọn quản lý màu sắc mà bạn 

sẽ học ở phần dưới đây. 

3. Di chuyển con trỏ qua từng phần của hộp thoại, bao gồm cả tên của từng vùng (như 

là Working Spaces) và những lựa chọn bạn có thể chọn (như là những menu lựa chọn 

khác nhau), trả lại giá trị mặc định của nó khi làm xong. Khi di chuyển con trỏ, để ý 

đến dòng thông tin xuất hiện ở phần dưới của hộp thoại. Hãy chọn một tập hợp lựa 

chọn chung và nó sẽ chỉ cụ thể cho từng lựa chọn một. Trong trường hợp này, sẽ chọn 

một lựa chọn được thiết kế để in ấn hơn là những sản phẩm đồ hoạ cho web. 

4. Chúng ta sẽ sử dụng xác lập “U.S. prepress Default” và nhấn vào nút “OK” 

In thử một tấm hình 

Trong phần này của bài học, chúng ta làm việc với dạng tài liệu đặc trưng có thể có 

được nhờ scan vào từ ảnh gốc. Mở nó ra, biến đổi thông số màu của nó, và thiết lập đó 

để khi in ra thì kết quả của nó cũng giống như khi nhìn nó trên màn hình. Điều này cho 

phép có một bản in thử trên màn hình của tài liệu muốn in ra giấy. Mở tài liệu đó: 

1. Trên thanh menu, chọn File > Open, mở file 20start.tif từ thư mục lesson20. Vì 

20start.tif đã bao gồm lược đồ màu cho bức ảnh được định nghĩa cho một không gian 

màu sắc khác với xác lập trên Photoshop, vì vậy sẽ xuất hiện hộp hội thoại “Embedded 

Profile Mismatch”, yêu cầu phải thay đổi xác lập màu. Có ba lựa chọn trong hộp hội 

thoại này: 

 Lựa chọn “Use the embedded profile” thay đổi những xác lập màu mà đã được 

định nghĩa từ những phiên làm việc trước theo những xác lập màu được sử 

dụng đi theo tập file ảnh. 

 Lựa chọn “Discard the Embedded Profile” hiển thị theo chế độ không có thông 

số màu đi theo và có thể sẽ gây ra việc màu sắc sẽ không được hiển thị chính 

xác. 

 Nói chung, nếu không vì những lý do đặc biệt, thì ta nên sử dụng lựa chọn thứ 2 

“Convert Document’s Colors to the Working Space”. 

2. Lựa chọn “Convert Document’s Colors to the Working Space” và nhấn OK. 
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Hình ảnh scan của tấm bưu tiếp sẽ hiện ra ở chế độ màu RGB 

Lựa chọn Convert Document’s Color to the Working Space yêu cầu Photoshop so 

sánh thông số màu của tập tin ảnh với thông số màu đã xác định trước đây trong hộp 

thoại Color Setting, và Photoshop sẽ chọn ra màu đúng nhất cho tập tin ảnh để hiển thị 

lên màn hình. 

 

Chú ý: Dựa vào những thông số đã được xác lập trong phần xác lập màu của 

Photoshop, nếu như tập tin ảnh không có phần định nghĩa xác lập màu đi theo, một cửa 

số xác nhận việc mất Thông số màu sẽ xuất hiện, cửa sổ này sẽ giúp ta có cần xác lập 

một tập thông số màu cho tập tin ảnh hay không. Cửa sổ này giúp ta lựa chọn việc sử 

dụng những thông số màu hiện hành hay chon từ những danh sách thông số có trong 

sẵn trong các tập thông số. Nói chung, ta nên lựa chọn xác lập màu hiện hành. 

Trước khi thực hiện việc sử lý màu sắc (trên màn hình) tức là việc chuẩn bị màu sắc 

trước khi in ấn, ta nên thiết lập trước các thông số (cũng còn được gọi là phần “proof 

setup”). Những thông số xác lập này nhằm mục đích chuẩn bị cho tập tin ảnh được in 

ra chính xác như những gì thể hiện trên màn hình. Photoshop có rất nhiều những xác 

lập dành cho từng trường hợp hiển thị màu sắc như in ấn, web hay màn hình. 

Trước khi "in thử" là dạng tạo một bản in trên màn hình hoặc thực sự in tấm hình, ta 

phải thiết lập thông số màu in thử. Thông số màu in thử (hay còn được gọi là Thiết lập 

in thử) xác định tài liệu này sẽ được in như thế nào, và sẽ thêm những tính năng thị 

giác đó vào phiên bản hiển thị trên màn hình để cung cấp một mẫu in thử chính xác 

hơn. Photoshop cung cấp một số lượng đa dạng những thiết lập mà có thể giúp bạn in 

thử một tấm hình cho nhiều mục đích sử dụng khác nhau, gồm cả in ra giấy và hiển thị 

trên màn hình. Trong bài học này sẽ học cách tạo một tuỳ biến thiết lập màu in thử. Có 

thể lưu lại những thiết lập này để sử dụng cho những bức hình khác và có cùng một 

kết quả đầu ra. 

3. Trên menu bar chọn View > Proof Setup > Custom. 

4. Đặt dấu kiểm trên lựa chọn Preview. 

5. Tại phần Profile trong hộp hội thoại Proof Setup, lựa chọn một xác lập phù hợp với 

nguồn nhận tập tin ảnh (ví dụ như máy in), trong trường hợp này, vì ta không đưa ra 

máy in, nên nói chung “Working CMYK - U.S. Web Coated (SWOP) v2” là một lựa 

chọn tốt. 

6. Phải đảm bảo rằng “Preserve Color Numbers” là không được lựa chọn. Việc gỡ lựa 

chọn này sẽ đảm bảo rằng, tập tin ảnh sẽ hiển thị được màu sắc gần nhất với thông số 

màu được thiết lập. 



85 
 

Chú ý: Lựa chọn này không có sẵn trên tất cả các hệ điều hảnh. Tiếp tục bước tiếp 

theo 

7. Từ menu Intent, chọn một loại Rendering bất kỳ cho việc biến đổi (chọn Relative 

Colorimetric, một lựa chon tốt cho việc bảo trì mối quan hệ của tập màu mà không làm 

mất tính chính xác của hệ màu đã xác lập) 

8. Nếu thống sô màu của bạn cho phép, Chọn Ink Black và sau đó chọn Paper White. 

Ta sẽ nhận ra độ tương phản của tấm hình bị mất đi nhiều. Lựa chọn này sẽ giả lập 

được màu đen thuần chứ không phải là màu đen nhợt), sau đó chọn Paper White (sẽ 

giả lập được màu trắng nhờ giống màu giấy thực. Điều đó cho thấy phần màu trắng ở 

tấm hình dưới là bắt chước màu trắng của giấy. 

9. Nhấn OK 

 

Để thay đổi xác lập màu, vào View-> Proof Colors 

 
* Xác định những gam màu nằm ngoài khả năng hiển thị của hệ màu 

Hầu như những bức ảnh được quét bao gồm hệ màu RGB, đều có phổ màu nằm trong 

hệ màu CMYK, việc chuyển đổi tập tin ảnh có hệ màu RGB sang hệ màu CMYK 

(thao tác mà ta sẽ làm trước khi in ra) hầu như không có mấy khác biệt. Mặc dầu vậy, 

những tập tin ảnh được tạo bởi công nghệ số có hệ màu RGB đều có phổ màu nằm 

ngoài hệ màu CMYK, ví dụ màu của ánh sang đèn nê-ông. 

Chú ý: Những gam màu nào không xác định được sẽ thể hiện một dấu chấm than 

trong cửa sổ màu (Color pallete) hay cửa sổ thông số màu (Info pallete). 

 

Trước khi ta muốn chuyển từ hệ màu RGB sang hệ màu CMYK, ta cần xem những giá 

trị màu CMYK khi tập tin ảnh vẫn còn trong hệ màu RGB. 

1. Chọn View -> Gammut Warning để xem những gam màu nằm ngoài hệ màu CMYK. 

Adobe photoshop xây dựng một bảng chuyển đổi và sử dụng màu xám trung tính để 

thể hiện những gam màu nằm ngoài hệ màu cần chuyển đổi. Bởi vì màu xám là màu 

rất khó nhận biết nên ta cần chuyển đổi nó tới màu dễ nhận biết hơn. 

2. Chọn Edit >Preferences > Transparency & Gamut, sau đó lựa chọn mẫu màu tại đáy 

của hộp hội thoại. 

3. Chọn một màu thật nổi hoặc thuần nhất như màu hồng hoặc màu xanh đậm. 
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4. Nhấn vào OK và đóng cửa sổ Transparency & Gamut lại. Màu xám sẽ được thay thế 

bởi màu ta đã chọn. 

5. Chọn View > Gamut Warning để gỡ bỏ chế độ xem các gam màu ngoài 

phổ màu. 

Photoshop sẽ tự động sửa những màu này khi ta lưu tập tin dưới dạng Photoshop EPS 

cuối chương này.Photoshop EPS sẽ chuyển đổi màu RGB tới màu CMYK, điều chỉnh 

những phổ màu trong RGB sao cho phù hợp với những phổ màu có trong CMYK. 

Điều chỉnh màu và chuẩn bị cho việc in ấn 

Bước tiếp theo là điều chỉnh màu cho tập tin ảnh được in ra. Trong chương này, chúng 

ta sẽ học cách thêm và điều chỉnh màu trên bức ảnh đã được quét. Để cho việc so sánh 

được chính xác, ta sẽ tạo một bản copy. 

1. Chọn Image > Duplicate, rồi chọn OK 

2. Đặt 2 bức ảnh trên màn hình sao cho có thể tiện so sánh nhất. 

Ở đây chúng ta sẽ điều chỉnh màu sắc và độ bão hòa màu. Có rất nhiều cách để điều 

chỉnh màu, đó là việc sử dụng Levels và Curves. Trong chương này chúng ta sẽ dung 

Hue/Saturation để điều chỉnh màu trong vùng làm việc.. 

3. Lựa chọn tập tin ảnh 20start.tif, rồi chọn Image > Adjustments > Hue/Saturation 

4. Chuyển vị trí cửa sổ hộp thoại sao cho có thể nhìn thấy ảnh trên màn hình. 

 Kéo thanh trượt trong phần Hue, sao cho đến lúc nhìn ảnh trông có vẻ tự nhiên 

hơn. 

 Kéo thanh trượt trên Saturation, sao cho cường độ màu trở về trạng thái bình 

thường. 

 Kéo thanh trượt thể hiện thuộc tính sang (Lightness) về vị trí 0 
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5. Vẫn với ảnh được lựa chọn, ta chọn File > Print With Preview 

6. Trong hộp hội thoại Print, cần đảm bảp rằng “Show More Options” được kiểm. Sau 

đó lựa chọn theo những bước dưới đây: 

 Ngay khi chọn “Show more Options” sẽ xuất hiện một trình đơn, chọn “Color 

Management”. 

 Trong phần “Source Space” chọn “Proof Setup”. 

  Trong phần “Print Space”, lựa chọn trong trình đơn “Profile” và “Intent” để có 

những thông số cho việc in ra máy in màu mà ta có ý định in ra. Nếu ta chưa có 

một máy in mặc định nào thì chọn “Working CMYK” 

 Sau đó chọn “Done” 

7. Chọn File –> Save để lưu tập tin. 

8. In ra một bản để so sánh với hình trên màn hình 

Lưu ảnh thành một tập tin riêng biệt 

Trong phần này ta sẽ học cách lưu ảnh thành tập tin riêng biệt, để có thể in ra phiên 

bản Cyan, Magneta, Yellow, Black riêng biệt. 

1. Chọn File > save as (Tất nhiên đối với tập tin 20start.tif). 

2. Trong họp hội thoại “save as”, lựa chọn những thuộc tính sau: 

 Tại trình đơn Format , chọn “Photo EPS”. 
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 Trong phần lựa chọn của “Save as”, với phần “Color” chọn “Use Proof Setup: 

Working CMYK”. 

Chú ý: Những lựa chọn này sẽ giúp cho tập tin ảnh tự động chuyển từ hệ màu RGB 

sang CMYK khi nó được lưu dưới dạng Photoshop Encasulated PostScrip (EPS) 

3. Đặt tên tập tin là 20start.eps rồi lưu lại. 

4. Nhấn vào nút OK, hộp hội thọai “EPS Options” sẽ xuất hiện. 

5. Chọn File > Open, rồi mở tập tin 20start.eps. Lưu ý rằng đây là tập tin CMYK. 

6. Sao lưu lại tập tin 20start.tif, bây giờ chỉ còn tập tin 20start.eps đang được mở. 

Lựa chọn cho in ấn 

- Để xác lập những thông tin cho việc in ấn, ta có thể chỉ định trong phần “File info” 

và “Print Preview”, sau đó xác lập từ phần “Options” từ cửa sổ hội thoại “Print”. 

Đăng nhập thông tin File 

Photoshop hỗ trợ chuẩn từ Hiệp hội báo chí Hoa kỳ và Hội đồng xuất bản Viễn thông 

quốc tế để xác định cơ chế truyền văn bản và hình ảnh. 

1. Trong tập tin ảnh 18start.eps, chọn File -> File Info. Cửa sổ hội thoại “File Info” sẽ 

xuấ hiện với tham số “General” trong phần “Section”. 
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2. Nhập những thông tin như : tiêu đề , tác giả, phụ đề…. 

Chú ý: Để in phần phụ đề cho tập tin ảnh, chọn File -> Print With Preview và chọn 

Description Option. 

3. Nhập từ khóa (Ví dụ : Skate hay winter) rồi nhấn vào nút Add. Ta có thể nhập bất 

kỳ một từ khóa nào ta thích. 

4. Trong List Menu chọn Origin. 

5. Nhấn vào “today” để lấy ngày hiện hành, hoặc có thể nhập vào bất kỳ ngày nào ta 

muốn, cũng tương tự đối với các thông tin khác. 

6. Nhấn vào OK để đóng cửa sổ hội thoại “File Info”, rồi chọn File > Save 
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Chú ý: Ngoài 2 lựa chọn trên của phần “Section”, nó còn có những lựa chọn khác mà 

ta có thể nhập thêm. 

In ấn 

Để đạt được kết quả tốt nhất cho việc in ra, ta nên theo những theo một số quy tắc sau: 

 Thiết lập các tham số cho màn hình bán sắc (halftone screen). 

 Nên in một bản in màu phối hợp (hay còn được gọi là color comp). Một bản in 

màu phối hợp nghĩa là bản in phối hợp các màu Đỏ, Xanh và Xanh dương 

(RGB) hoặc CMYK. Việc này sẽ làm cho bản in ra giống với hình ảnh ta đã 

nhìn thấy trên màn hình. 

 In tách dời để tấm hình được tách dời đúng cách. 

 In ra film 

In tráng ảnh bán sắc 

Để chỉ định một màn hình bán sắc khi in một tập tin ảnh, ta sử dụng lựa chọn Screen 

trong cửa sổ hội thoại Print With Preview. Kết quả của sử dụng màn hình bán sắc chỉ 

có trong bản sao được in, ta không thể xem được màn hình bán sắc trên màn hình. 

 

Ta sử dụng màn hình bán sắc để in ra một bức ảnh màu xám. Ta sử dụng bốn màn hình 

bán sắc (một cho mỗi tiến trình màu) để in ra những màu riêng biệt. Trong ví dụ này, 

chúng ta sử dụng việc điều chỉnh tần số màn hình và chấm điểm để tạo ra màn hình 

đơn sắc cho bức ảnh có gam màu xám. 

 

Tần số màn hình kiểm soát mật độ các điểm trên màn hình. Các điểm được sắp xếp 

theo dòng trên màn hình, đơn vị đo lường thong thường cho tấn số trên màn hình là 

dòng trên inch (lpi). Nếu tần số màn hình càng cao, thì ảnh càng đẹp (lệ thuộc vào khả 

năng quét dòng màn hình của máy in). Những tạp chí thường sử dụng những màn hình 

có tần số quét dòng tốt như 133 lpi hoặc cao hơn, vì họ in ấn trên các loại giấy được 

tráng phủ hoặc những ấn bản có chất lượng cao.Báo chí thì lại được in với chất lượng 

thấp hơn lên chỉ cần những màn hình có tần số quét dòng khoảng 85 lpi. 

 

Góc màn hình được sử dụng để tạo bán sắc cho ảnh màu xám khoảng 45độ. Để đạt 

được kết quả tốt nhất cho các màu riêng biệt là sử dụng lựa chọn Auto trong cửa sổ hội 

thoại Halftone (chọn Page Setup -> Screens ->Halftone Screens). Ta cũng có thể chỉ 

định góc cho từng màu. Nên thiêt lập các màn hình với các góc khác nhau để đảm bảo 

rằng các chấm điểm đặt trên bốn màn hình có vẻ là có màu liên tục và không tạo ra 

việc nhiễu màu. 

 

Những chấm điểm dạng hình thoi thường được sử dụng trong màn hình bán sắc, tuy 

nhiên Photoshop cũng cho phép ta sử dụng các dạng hình khác như : tròn, e líp, gạch 

nối, đường kẻ. 
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Chú ý: Mặc định một ảnh sẽ sử dụng những xác lập màn hình bán sắc của thiết bị 

hoặc phần mềm nơi mà ta xuất tập tin ảnh, như chương trình dàn trang. Ta không cần 

phải chỉ định những xác lập màn hình đơn sắc như dưới đây trừ trường hợp ta muốn 

chèn đè lên những xác lập mặc định. 

 

1. Đảm bào rằng cửa sổ của tập tin ảnh đã được kích hoạt. 

2. Chọn Image > Mode > Grayscale sau đó chọn Ok để hủy bỏ thong tin màu. 

3. Chọn File > Print With Preview để đảm bảo Show More Options được lựa chọn. 

4. Lập tức cửa sổ Show More Options sẽ xuất hiện, lựa chọn “output” từ trình đơn bên 

dưới 

 
5. Nhấn vào Screen để mở cửa sổ hội thoại “Halftone Screen” và lựa chọn những 

thông tin dưới đây: 

 Gỡ bỏ lựa chọn “Use Printer’s Default Screen”. 

 Phần Frequency nhập số 133, và đảm bảoLines/Inch được lựa chọn. 

 Phần Angle chọn góc 45độ. 

 Phần Shape chọn Elipse. 

 Nhấn Ok để đóng cửa sổ Halftone Screen 
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6. Nhấn vào “Done” để đóng cửa sổ “Print With Preview” 

7. Để in ảnh, chọn File -> Print 

8. Chọn File > Close để đóng tập tin ảnh (không lưu giữ những gì đã thay đổi) 

In ấn những bản riêng biệt 

Mặc định, ảnh hệ màu CMYK được in ra như một tập tin ảnh duy nhất, và là một tập 

tin ảnh hợp thành của bốn màu. Để in ra thành bốn tập tin ảnh riêng biệt, ta cần lựa 

chọn phần Separations trong cửa sổ hội thoại “Print With Preview”. 

 

Để in ảnh hiện thời theo gam màu, ta làm như sau : 

1. Chọn File > Open và mở tập tin 18start.eps. 

2. Chọn File > Print With Preview. 

3. Trong cửa sổ hội thoại “Print”, đảm bảo rằng đã lựa chọn “Show More Options”, và 

xác lập theo như những thông tin dưới đây 

  Trong trình đơn pop-up ngay bên dưới “Show more Options”, chọn “Color 

Management”. 

 Trong phần “Source Space” chọn Document. 

 Trong trình đơn pop-up Profile, chọn “Separations”. 
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4. Nhấn vào Print (Nếu ta không muốn in ra, có thể bỏ qua bước này). 

5. Chọn File > Close để đóng tập tin (Nhớ không lưu). 

Tới đây chúng ta đã hoàn tất việc sử dụng màu riêng biệt va in ấn cho một tập tin ảnh 

trong Adobe Photoshop. 

Câu hỏi ôn tập 

1. Có những bước gì để tái tạo màu chính xác ? 

2. Gam màu là gì? 

3. ICC profile là gì? 

4. Màu riêng biệt là gì ? Ảnh hệ màu CMYK khác với hệ màu RGB như thế nào ? 

5. Những bước nào để chuẩn bị in ra những màu riêng biệt trong một tập tin ảnh ? 

Đáp án 

1. Xác định cỡ màn hình, sau đó sử dụng cửa sổ “Color Setting” để xác lập thông tin 

về không gian màu. Ví dụ : Ta có thể sử dụng hệ màu RGB cho những ảnh trực tuyến, 

hệ màu CMYK cho những ảnh được in ra. 

 

2. Ta cũng có thể chuẩn bị trước khi cho in ra những tấm ảnh, kiểm tra những gam 

màu không nằm trong những gam màu của hệ màu đã chọn, điều chỉnh màu theo ý 

muốn, đối với những ảnh cần in ra, có thể in ra những ảnh có gam màu riêng biệt. 

 

3. Gam màu là phạm vi màu được tái tạo lại bởi thiết bị hoặc hệ màu, ví dụ, hệ màu 

RGB và CMYK là 2 hệ màu khác nhau nên cho những bức ảnh khác nhau. 

 

4. ICC profile là tập thông tin đặc tả không gian màu của một thiết bị, ví dụ như hệ 

màu CMYK đặc tả khôn ggian màu của một loại máy in. Những ứng dụng như 

Photoshop sử dụng ICC Profile cho lưu trũ thông tin màu của tập tin ảnh để khi 

chuyển qua các ứng dụng khác vẫn giữ được nguyên màu sắc của chúng. 

 

5. Chuẩn bị ảnh được in ra có thể giữ được màu chuẩn, sau đó chuyển đổi từ hệ màu 

RGB sang hệ màu CMYK để xây dựng được những gam màu riêng biệt. 

 

  - 
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Bài 9. BỘ LỌC 

Mã bài: MĐ17-09 

Mục tiêu 

+ Ứng dụng các bộ lọc có sẵn của Photoshop để thay đổi màu sắc, hình dáng 

của ảnh. 

+ Áp dụng nhiều hiệu ứng như mờ, phác hoạ, hiệu ứng ánh sáng, chuyển động 

mờ, lóa ống kính, noise… 

Nội dung chính 

I. Nhóm Render 

Các bộ lọc Render tạo hình dạng 3D, mẫu khúc xạ, và mô phỏng kết quả phản xạ ánh 

sáng trong hình ảnh. Ngoài ra có thể thao tác đối tượng trong không gian 3D, tạo đối 

tượng 3D. 

1. 3D Transform 

Ánh xạ hình ảnh trên các khối vuông, khối cầu, và khối trụ, có thể xoay chúng theo ba 

chiều. 

2. Clouds 

Tạo ra mẫu thức bằng cách dùng các giá trị ngẫu nhiên biến đổi giữa màu tiền cảnh và 

màu nền (tạo hiệu ứng mây). 

3. Difference Clouds 

Sử dụng các giá trị ngẫu nhiên biến đổi giữa màu tiền cảnh và màu nền nhằm tạo nên 

mẫu thức mây. Nó hòa trộn dữ liệu mây với các điểm ảnh y như chế độ Difference hòa 

trộn các màu. 

4. Lens Flare 

Giả lập hiện tượng khúc xạ ánh sáng, cực sáng thẳng vào camera (còn gọi là hiện 

tượng ngược sáng). 

http://voer.edu.vn/bai-viet/khoa-hoc-va-cong-nghe/nhom-render.html
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II. Bộ lọc Texture 

Các bộ lọc Texture cung cấp cho hình ảnh dáng vẻ của độ sâu hay tình trạng của vật 

chất trong thực tế, hoặc bổ sung một dáng vẻ hữu cơ. 

1. Craquelure 

Tạo hiệu ứng trông như ảnh được vẽ trên một bề mặt trát vữa sần sùi, hình thành một 

mạng lưới rỗ chằng chịt theo các cạnh nền màu. 

2. Grain 

Bổ sung dạng kết cấu vào hình ảnh bằng cách giả lập các loại hạt khác nhau. 

3. Mosaic Tiles 

Làm cho hình ảnh trông như được ghép thành từ nhiều mảnh nhỏ hoặc ghép lặp, đồng 

thời bổ sung các kẽ hở giữa các mảnh. 
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4. Patch Work 

Phá vỡ hình ảnh thành các mảnh vuông được tô bằng màu trội trong khu vực. 

5. Stained Glass 

Chức năng Stained Glass vẽ lại hình ảnh ban đầu bằng các hình đa giác không đều liên 

kết với nhau. Mỗi hình đa giác có một màu đơn. 

6. Texturizer 

Áp lên hình ảnh một dạng kết cấu do ta chọn hoặc tự tạo. 
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III. Bộ lọc Distort 

Các bộ lọc Distort làm biến dạng hình học của hình ảnh, tạo hiệu ứng 3D hoặc tái tạo 

hình dạng khác. Lưu ý, những bộ lọc này có thể chiếm dụng rất nhiều dung lượng nhớ. 

Ảnh gốc: 

1. Diffuse Glow 

Hình ảnh tựa như được nhìn qua bộ lọc khuếch tán mờ dịu. Bộ lọc này đưa thêm sọc 

trắng vào hình ảnh, với quầng sáng mờ dần từ tâm vùng chọn. 

2. Displace 

Bộ lọc này sử dụng một ảnh PSD, gọi là họa đồ thay thế để quyết định cách biến dạng 

một vùng chọn. 
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3. Glass 

Làm cho hình ảnh hiển thị như thể được nhìn ngắm qua các kiểu kính khác nhau. 

4. Ocean Ripple 

Thêm những gợn sóng cách nhau một cách ngẫu nhiên vào bề mặt hình ảnh, làm cho 

hình ảnh tựa như ở dưới nước. 

5. Pinch 

Xoáy vùng chọn. Giá trị dương tối đa 100% sẽ xoắn vùng chọn vào tâm, giá trị âm tối 

đa –100% sẽ xoắn vùng chọn hướng ra ngoài. 
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6. Polar Coordinates 

Chuyển vùng chọn từ tọa độ vuông góc sang tọa độ cực và ngược lại. 

7. Ripple 

Tạo mẫu gợn sóng trên vùng chọn, y hệt sóng nước lăn lăn trên mặt hồ. Muốn chi phối 

hiệu ứng ở mức cao hơn, hãy dùng bộ lọc Wave. 

8. Shear 

Làm biến dạng hình ảnh dọc theo đường cong. Xác định đường cong bằng cách kéo 

vạch trong hộp để tạo đường cong biểu thị mức biến dạng. 
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9. Spherize 

Cung cấp hiệu ứng 3D cho đối tượng bằng cách bao quanh hình dạng cầu, làm biến 

dạng hình ảnh và kéo dãn hình ảnh sao cho khớp với đường cong đã chọn. 

10. Twirl 

Xoáy hình ảnh mạnh dần về phía tâm. Việc chỉ định góc sẽ tạo ra một mẫu thức xoáy. 

11. Wave 

Hoạt động tương tự như bộ lọc Ripple nhưng mức chi phối cao hơn. Các tùy chọn bao 

gồm số bộ sinh sóng, độ dài sóng, độ cao sóng, và kiểu sóng. 
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12. Zigzag 

Làm biến dạng ảnh theo hướng xuyên tâm với các đường chữ chi. Ta có thể xác lập số 

bước nghịch hướng trên đường chữ chi. Hiệu ứng tạo cảm giác như ném viên đá xuống 

nước, nước loang ra. 

Để có được ánh phản chiếu màu trắng, ta có thể dùng cọ Brush màu trắng vẽ vài nét 

lên hình trước khi áp dụng hiệu ứng. 

IV. Bộ lọc Blur 

Các bộ lọc Blur làm mờ vùng chọn hoặc hình ảnh, rất hữu ích trong việc chấm sửa ảnh. 

Có thể tạo bóng mờ cho hình ảnh. 

Ảnh gốc: 
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1. Blur 

Tạo hiệu ứng làm mờ hình ảnh, tạo cảm giác về sự mềm mại. Các biên cạnh màu của 

hình ảnh cường độ mịn có giá trị thấp. 

2. Blur More 

Tạo hiệu ứng làm mờ hình ảnh có hiệu ứng mạnh gấp ba, bốn lần so với Blur. 

3. Gaussian Blur 

Nhanh chóng làm nhòe vùng chọn theo mức độ có thể điều chỉnh. Giá trị Radius càng 

cao thì mức độ nhòe càng mạnh. 

4. Motion Blur 

Làm nhòe theo hướng cụ thể (từ –360 độ đến + 360 độ) và cường độ xác định (từ 1 – 

999). Hiệu ứng của bộ lọc này tương tự như chụp ảnh đối tượng đang chuyển động. 
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5. Radial Blur 

Làm nhòe một cách đa dạng và phong phú hơn. Nó tạo ra vòng xoáy đồng tâm hoặc 

theo đường hướng tâm (Spin, Zoom). 

 Spin: Làm nhòe dọc theo các đường tròn đồng tâm (cuộn xoáy) 

 Zoom: Làm nhòe theo đường hướng tâm 
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6. Smart Blur 

Làm nhòe chính xác hình ảnh. Làm nhiệm vụ tinh lọc các mảng màu. Nó chuyển hóa 

hình ảnh về dạng đơn giản của các pixel màu. 

Kết luận: Việc sử dụng các bộ lọc (Filter) phải áp dụng đúng cho từng loại hình ảnh, 

để các hiệu ứng bộ lọc đạt hiệu quả cao. 
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CÁC PHÍM TẮT TRONG PHOTOSHOP 

 

Trong Photoshop hầu hết các công cụ đều có lệnh gõ tắt từ bàn phím, nó khiến cho 

việc sử dụng các công cụ nhanh hơn và linh hoạt hơn. 

Khi được sử dụng kết hợp với chuột, những lệnh gõ tắt sẽ giúp tăng tốc độ và hiệu suất 

làm việc lên rất nhiều. 

 

1. Toolbox 

Những lệnh gõ tắt của Toolbox là một chữ cái. Nếu một công cụ nào đó có hơn một 

lựa chọn, như là Elliptical và Rectangular Marquee, chỉ việc nhấn lệnh gõ tắt thêm 

một lần nữa để đổi sang công cụ kia. 

Marquee tools : Phím M 

Crop tool : Phím C 

Move tool : Phím V 

Lasso tool : Phím L 

Magic Wand : Phím W 

Airbrush : Phím A 

Paintbrush : Phím B 

Eraser : Phím E 

Pencil : Phím Y 

Rubber Stamp : Phím S 

Smudge tool : Phím U 

Sharpen/Blur tools : Phím R 

Sponge/Burn/Dodge : Phím O 

Pen tool : Phím P 

Text tool : Phím T 

Line tool : Phím N 

Gradient tool : Phím G 

Paintbucket : Phím K 

Eyedropper : Phím I 

Hand : Phím H 

Zoom : Phím Z 

 

 

 

2. Files 

New file: Ctrl + N 
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Open file: Ctrl + O 

Close file: Ctrl + W 

Save file: Ctrl + S 

Save As: Ctrl + Shift + S 

Save a Copy: Ctrl + Alt + S 

Page Setup: Ctrl + Shift + P 

Print: Ctrl + P 

Preferences: Ctrl + K 

Exit: Ctrl + Q 

 

3. Editing 

Undo/Redo: Ctrl + Z 

Cut: Ctrl + X 

Copy: Ctrl + C 

Copy Merged: Ctrl + Shift + C 

Paste: Ctrl + V 

Paste Into: Ctrl + Shift + V 

Fill (background color) : Ctrl + Backspace 

Fill (background color, preserving transparency): Ctrl + Shift + Backspace 

Fill (foreground color) : Alt + Backspace 

Fill (foreground color,preserving transparency): Alt + Shift + Backspace 

 

 
4. Image 

Levels: Ctrl + L 

Auto Levels: Ctrl + Shift +L 

Curves: Ctrl + M 

Color Balance: Ctrl + B 

Hue/Saturation: Ctrl + U 

Desaturation: Ctrl + Shift + U 

Invert: Ctrl + I 

 
5. Layers 

 

Group with Previous: Ctrl + G 
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Ungroup: Ctrl + Shift + G 

Free Transform: Ctrl + T 

Merge Layers: Ctrl + E 

Merge Visible: Ctrl + Shift + E 

Select All: Ctrl + A 

None: Ctrl + D 

Inverse: Ctrl + Shift + I 

Feather: Ctrl + Shift + D 

 

6. Filters 

 

Last Filter: Ctrl + F 

Fade: Ctrl + Shift + F 

 

7. View 

 

CMYK Preview: Ctrl + Y 

Gamut Warning: Ctrl + Shift + Y 

Zoom In: Ctrl + + 

Zoom Out: Ctrl + - 

Fit On screen: Ctrl + 0 

Actual Pixels: Ctrl + Alt + 0 

Hide Edges: Ctrl + H 

Hide Path: Ctrl + Shift + H 

Show Rulers: Ctrl + R 

Hide Guides: Ctrl + ; 

 
Snap to Guides: Ctrl + Shift + ; 

Lock Guides: Ctrl + Alt +; 

Show Grid: Ctrl + " 

Snap to Grid: Ctrl + Shift + " 

 

8. Nhóm Phím F 

 

F1 : Mở trình giúp đỡ 



108 
 

F2 : Cắt 

F3 : Copy 

F4 : Paste 

F5 : Mở pallete brush 

F6 : Mở pallete màu 

F7 : Mở pallete layer 

F8 : Mở pallete info 

F9 : Mở pallete action 

 

 

9. Nhóm Phím Chức Năng 

 

TAB : tắt/mở các pallete 

SHIFT + TAB : tắt/mở các pallete trừ pallete tool 

CTRL + SPACEBAR : phóng to 

ALT + SPACEBAR : thu nhỏ 

ALT + DELETE : tô màu foreground 

CTRL + DELETE : tô màu background 

CTRL + SHIFT + N : tạo layer mới hiện hộp thoại 

CTRL + SHIFT + ALT + N : tạo layer mới không hiện hộp thoại 

CTRL + Click vào layer trong bảng layer : tạo vùng chọn xung quanh layer 

CTRL + ALT + D hoặc SHIFT + F6 : tạo Feather 

CTRL + I : nghịch đảo màu 

CTRL + L : mở bảng Level 

CTRL + M : mở bảng Curver 

CTRL + B : mở bảng Color balance 

SHIFT + F7 hoặc CTRL + SHIFT + I : nghịch đảo vùng chọn 

ALT + I + I : xem thông số file hiện hành 

/ : khóa layer 

SPACEBAR + rê chuột : di chuyển vùng ảnh qua lại 

CTRL + J : sao chép layer 

CTRL + E : merge layer hiện hành với layer đừng phía dưới 

CTRL + SHIFT + E : merge tất cả các layer đang có 

CTRL + ] : đẩy layer hiện hành lên một cấp 

CTRL + [ : đẩy layer hiện hành xuống một cấp 
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ALT + ] : chọn layer hiện hành lần lượt từ dưới lên trên 

ALT + [: chọn layer hiện hành lần lượt từ trên xuống dưới 

SHIFT + dấu cộng ( + ) : chọn chế độ Blend mode lần lượt từ trên xuống dười 

SHIFT + dấu trừ ( - ) : chọn chế độ Blend mode lần lượt từ dưới lên trên 

ALT + double click vào layer background : đổi layer background thành layer 0 

Double click vào vùng trống: mở 1 file có sẵn 

CTRL + double click vào vùng trống: tạo 1 fle mới 

Nhập số bất kỳ : thay đổi chế độ mờ đục Opacity 

D: trở lại màu mặc định đen/trắng 

X : nghịch đảo 2 màu background và foreground 

CTRL + R: mở thước đo 

CTRL + F: thực hiện hiệu ứng thêm một lần nũa 

CTRL + ALT + F: thực hiện lại hiệu ứng một lần nữa nhưng hiện thị hộp thoại để thay 

đổi thông số 

CTRL + > (dấu lớn hơn): tăng size chữ (đã chọn toàn bộ nội dung text bằng công cụ 

text) 

CTRL + < (dấu nhỏ hơn): giảm size chữ (đã chọn toàn bộ nội dung text bằng công cụ 

text) 

CTRL + W: đóng file đang mở 

Các dấu mũi tên: di chuyển vùng chọn sang 1 pixel 

SHIFT + Các dấu mũi tên: di chuyển vùng chọn sang 10 pixel 

CTRL + Z: undo duy nhất 1 lần 

CTRL + ALT + Z: undo nhiều lần 

CTRL + SHIFT + Z: redo nhiêu lần 

CTRL + U: mở bảng Hue/Saturation 

CTRL + SHIFT + U: đổi thành màu trắng đen 

CTRL + ENTER: biến 1 đường path thành vùng chọn 

CTRL + T: thay đổi kích thước layer ở những chế độ khác nhau 

ALT+ S + T: thay đổi kích thước vùng chọn ở các chế độ khác nhau 

Dấu ] : tăng size các công cụ tô 

Dấu [ : giảm size các công cụ tô 

 

10. Nhóm Phím Công Cụ 

 

Nhóm công cụ nào có hình tam giác nhỏ nằm ở phía góc phải bên dưới sẽ còn một số 

công cụ nằm ở bên trong nữa. Để chuyển đổi qua lại các công cụ trong cùng một nhóm, 
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giữ SHIFT + phím : nhấn phím tắt của các công cụ nhiều lần hoặc giữ ALT + Click 

chuột vào công cụ nhiều lần (không buông SHIFT hoặc ALT). 

 

11. Nhóm phím tạo vùng chọn 

Khi ở trong các phím tạo vùng chọn, giữ SHIFT để tăng thêm vùng chọn, giữ ALT để 

giảm bớt vùng chọn, ALT + SHIFT lấy vùng giao nhau giữa 2 vùng chọn. 

M : tạo vùng chọn hình chữ nhật/hình tròn 

L : tạo vùng chọn tự do 

W : tạo vùng chọn cùng thuộc tính màu 
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